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Hardware 

Introduction 

Spider-20 is a compact yet powerful digital data recorder and dynamic signal 
analyzer. It provides four 24-bit precise high-fidelity input channels, and a unique 
software-selectable tachometer-input/signal-source output channel (all using 
conventional BNC connectors). Each input is individually programmable to accept 
AC or DC voltage or output from an IEPE (ICP) sensor with built-in electronics.  

Spider-20 is a diminutive 5 5/16 x  45/16 x  15/16 inch tool weighing only 18 ounces. 
It has only three push-button controls and five LED status indicators. This little 
powerhouse can run over 6 hours on its internal rechargeable battery which can be 
replaced in field with a backup battery. It can also record data on its built-in 4GB 
flash memory at the simple push of a button.  

Spider-20 communicates with the world through its built-in Wi-Fi interface. Use 
your iPad to setup and view or record time histories as well as perform spectrum 
analysis or measure Frequency Response and Coherence functions. Link the 
Spider-20 to your laptop or tablet running Windows and enjoy the full repertoire of 
functionality provided by our EDM (Engineering Data Management) software 
including 1/nth Octave acoustic functions, Order Tracking for rotating machinery, 
Shock Response Spectra for drop testing, or Digital Filtering for special purpose 
analysis.  

Transfer measured data to truly massive storage space using the EDM Cloud server. 
EDM can be used to program your Spider-20 to perform a custom measurement or 
measurement sequence at the touch of its START button, making it an 
unintimidating and user-friendly tool. No computer, tablet or phone is required; 
just use your thumb and your Spider-20 operating in Black Box mode. Use our 
flexible Automated Schedule and Limiting software to turn this Spider into an 
intelligent unattended monitor capable of responding to data conditions or 
networked instructions, notifying you of significant conditions via e-mail. 

Spider-20E is the Ethernet version of Spider-20. Spider-20E communicates with 
the world through Ethernet interface. It requires additional wireless router to 
communicate with iPad.  

Spider-20/20E is the perfect solution to many applications including: 

Machinery Diagnosis 

Four inputs and a tachometer channel are the perfect size for many machinery 
monitoring tasks. Simultaneously measure two perpendicular proximity probes or 
horizontal and vertical bearing cap accelerations at both ends of a machine. Record 
this along with a 1/rev tachometer during startups and shutdowns to plot waterfalls 
and Campbell diagrams identifying resonances, critical speeds and unusual forcing 
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functions. Use the same signal inputs to balance the machine. Place accelerometers 
on either side of a coupling to aid alignment. 

 

Machine/Process Monitoring 

Load a custom monitoring program employing our Automated Schedule and 
Limiting software and leave your Spider-20 to monitor speed and four dynamic 
inputs. Upon detecting an alarm-level limit (in the time or frequency domain), it 
can send you an email reporting the finding and make an immediate recording for 
more detailed analysis. For longer stays, leave the accessory AC power unit plugged 
in. This allows Spider-20 to draw power (6 Watts, maximum) from any 100 to 240 
VAC (47 – 440 Hz) power line. Alternatively, you can provide a battery backup of 15 
VDC (±10%) for more remote applications.   

Modal Analysis 

Four signal inputs allow you to measure a force and three accelerations. Use a fixed 
tri-axial accelerometer or up to 3 separate reference accelerometers and a force-
transduced hammer to perform impulse studies (with redundant measurements). 
Alternatively, turn on the output channel and let the Spider drive a shaker with 
random noise while you rove a tri-axial around the structure, measuring 3 degrees 
of response freedom at a time. Switch the shaker drive to a sinewave at a detected 
resonance frequency to do a quick hand-and-ear mode shape analysis on the spot. 

Acoustic Studies 

Add an ICP microphone and your iPad or iPhone becomes a full function sound 
level meter. Add 3 more and it becomes a multi-channel, multi-function sound level 
recorder and analyzer. Use it with an intensity probe for noise source localization. 
Take the Spider-20 on the road or in the air to record interior noise signatures 
during full-spectrum vehicle operation. Make and monitor pass-by measurements 
from the vehicle. Validate all of your recordings in-place on your tablet or laptop 
before returning to base. 

Vehicle Dynamics 

Record speed and four DC-coupled accelerometers to fully document chassis 
handling characteristics. Record any combination of acceleration, displacement, 
strain and sound to characterize annoying operational periods. Monitor engine and 
driveline vibration on your remote screen during road tests, whether you are the 
driver, a passenger or a standing observer.  

Temporary Monitor 

Let‘s face it – sometimes things just go wrong and we don‘t know why. This can 
happen in the factory or at a remote installation and occurs even with brand new 



 

11 Crystal Instruments Spider-20/20E Manual 

products. The problem may be sonic or something shaking or breaking. The 
mission is always the same – find out what‘s causing the problem and correct it. A 
few simple measurements made over the course of a day or a week may provide the 
necessary clue to solve this annoying mystery. Spider-20 is ideal for such ―detective 
work‖. Through EDM it has a very flexible measurement repertoire and the ability 
to take various actions based upon instantaneous data conditions and other 
(networked) stimuli.  Spider-20 is small, silent, draws little power, and is 
inexpensive to replace. It‘s the right kind of instrument to lock down in an 
unexpected place for an exploratory ―look-and-see‖.  

A standard shipping package will include a Spider-20 unit with batteries installed, a 
pair of backup batteries, a battery charger, one 3ft BNC cable, an AC power adapter 
CD for software and the calibration certificate. 

What is Included in the Box 

Included Accessories: 
 

Item # Description Qty PN 

1 Soft Bag 1 S20-A13 
2 Spider-20/20E Battery (Installed) 2 S20-A02 
3 Spider-20/20E Battery (Additional) 2 S20-A02 
4 Battery Charger 1 S20-A16 
5 BNC Cable: 3 feet 1 S20-A03 
6 CD for EDM, the host software, User’s Manual in PDF  1 S20-A90 
7 AC/DC Power Adapter 1 S20-

A11NA 8 Universal Power Plug 1 
9 Certificate of Calibration  1 S20-A93 
10 Certificate of Conformance 1 S80-A95 

 

Quick Setup Guide 

The Spider-20/20E is controlled by Engineering Database Management software in 
both Windows version (referred as EDM) and iOS version (referred as EDM App).  

The EDM software runs on several different hardware platforms from Crystal 
Instruments:  

 Spider-81: an 8-channel device that can be expanded to a system with 
hundreds of channels.  

 Spider-81A: a 16-channel dedicated controller 

 Spider-81B: a 4-channel economic version of Spider-81 
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 Spider-81C: a 2-channel compact-size and Wi-Fi version of Spider-81 

 Spider-80X, a compact packaging of Spider-81 that can be expanded to a 
system with hundreds of channels 

 Spider-20/20E, a 4-channel handheld Wi-Fi/Ethernet enabled signal 
analyzer and data recorder. 

When there is no confusion, this manual refers the hardware platforms above as 
―Spider‖. When the description is specifically related to a type of hardware, the 
product model number will be mentioned.  

Important Safety Information 

The Spider product complies with: 

EN 61326:1997+A1:1998+A2:2001 

EN61000-3-2: 2000 & EN61000-3-3: 1995+A1:2001 

The Spider and its accessories should be used only as specified in this User‘s 
Manual or the warranty protection provided by Crystal Instruments may be void.  

Condensation may form on the circuit boards when the device is moved from a cold 
environment to a warm one. In these situations, always wait until the device warms 
up to room temperature and is completely dry before turning it on. This 
acclimatization should take about 2 hours. 

For the most accurate measurements, a warm-up phase of 20 minutes is 
recommended.  

These devices have been designed for use in clean and dry environments. They are 
not to be operated in 1) exceedingly dusty and/or wet environments, 2) in 
environments where danger of explosion exists, and 3) in environments containing 
aggressive chemical agents. 

Always lay cables in such a manner as to avoid tripping hazards. 

A Warning identifies conditions and actions that pose hazard(s) to the user. A 
Caution identifies conditions and actions that may damage the instrument. 

To avoid electrical shock or fire: 

1. The Spider is a low voltage measurement instrument.  
2. Do not apply input voltages above the rating of the instrument. Never 

apply a voltage that potentially exceeds ±20 V.  
3. Review the entire manual before using the instrument and its 

accessories. 
4. Do not operate the instrument around explosive gas or vapor. 
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5. Before use, inspect the instrument, BNC connectors and accessories 
for mechanical damage and replace if damaged. Look for cracked or 
missing plastic. Pay special attention to the insulation surrounding 
the connectors. 

6. Remove the cables and accessories that are not in use. 
7. Use the ground input only to ground the instrument. Do not apply 

any voltage. 
8. Do not insert metal objects into connectors. 
9. Use only the wall-mount AC Adapter provided by Crystal Instruments. 

AC Adapter Voltage Range 

For external power sources the Spider-80X uses a wall-mount AC adapter. The AC 
Power range is: 100 – 240VAC, 47 – 440 Hz. 

Maximum Measurement Input Voltage 

The maximum working input voltage is 20 V peak. Voltage ratings are given as 
―working voltage‖. They should be read as Vpeakfor dynamic applications and as VDC 
for DC applications. 

The maximum input range without damaging the hardware is 40Vpeak. 

Connecting Your PC to the Spider Front-End 

You can connect the Spider modules through an Ethernet LAN or 
directly to your PC using an Ethernet crossover cable. There is a CAT-5 
100Base-T jack on the rear of the modules. 

If your Spider system consists of more than one module, you will need to connect 
the modules with a network switch or router. It is recommended that your system 
use a private LAN rather than a shared office LAN. Spider hardware supports IEEE 
1588 time synchronization. To scale the measurement system with more than one 
Spider unit, an Ethernet switch supporting IEEE 1588 is highly recommended. 

 

Figure 1: Topology 

Set Master or Slave Mode 

The M/S switch on the back of each unit is used to control whether it is 
configured as a Master or a Slave. For a system with multiple units, only 
one can be configured as a Master, and all others must be set as Slaves.  
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If you are using only one module, the system will automatically configure it as a 
Master regardless of the switch position. If additional modules are added at a later 
date, it will be necessary to configure the first module as the Master and each of the 
additional modules as Slaves. 

Connect the Power Adapter 

Connect the power adapter to the power jack on the rear of the device and to an AC 
power source. The power adapter is an AC to DC converter that accepts 100 – 240 
VAC(47 – 440 Hz) and outputs 15VDC. The total power consumption is less than 10 
watts during full operation. 

 

Turn Spider Power On 

After the Ethernet cable and power adapter are connected to the Spider, press the 
Power button on the front of the unit. The LAN LED will illuminate. 

 

 

IP Setup 

When each Spider is shipped, unless the user has requested otherwise, it is set by 
default to the Dynamic Host Configuration Protocol (DHCP). If no DHCP server is 
found when Spider is connected to a PC or LAN, the device will resort to a link-
local address auto configuration. In this mode, the device randomly chooses 
an address in the 169.254.x.x address space. 

Since all this happens automatically, the IP settings of the Spider modules should 
not need to be manually set.  

If a static IP configuration is required, IP settings of the Spider can be changed with 
the Spider IP Address SetupToolthat was installed with EDM. This tool is located 
in the EDM installation folder. It is called ―EDM.SetIP.exe‖. 
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Figure 2: Set Device IP Address 

Each connected hardware module will be listed by serial number. To change 
settings, select a module, enter the desired IP address, subnet mask, and default 
gateway, and click Set Spider IP. You can also choose to have the IP settings 
automatically assigned via DHCP. The LED on the Spider will flash for a couple 
seconds, indicating that the new IP has been assigned. It is helpful to keep track of 
the IP address of each module and its physical location. 

Reset Device button allow users to restart the hardware system without pressing 
the power button on the hardware. Restarting the device remotely provides great 
convenience for remote testing. The tool returns the status whether the system is 
restarted successfully. 

Watchdogallows the software to automatically monitor whether the hardware 
system is running normally. Watchdog is off by default; when Watchdog is on, the 
software will remotely restart the hardware if the hardware system hangs or is 
interrupted during a complicated test. The user does not need to physically touch 
the hardware to restart it. Watchdog is suggested for situations when the system 
does remote monitoring and is not easily accessible.. 

Resetting to Factory Default IP Settings 

To reset to the factory default IP address of 192.168.1.153 for the Spider-80X, press 
and hold the Resetbutton on the back of the unit for 4 seconds. 

Computer Network Settings 

The network settings on the PC must have a matching subnet and subnet mask in 
order to communicate with a Spider module. If both the computer and the Spider 
module are set to use DHCP, then they will automatically configure matching IP 
addresses with the correct matching subnet settings. 

To verify the network connection, use the PING command in the Command Prompt 
window on the PC. In the Windows Start Menu, select Run, type ping 192.168.1.182 
(the actual IP of your Spider), and press enter. (Note: replace the factory default IP, 
192.168.1.182, with the actual configured IP address of the device. 
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If it is correctly configured, the ping command will receive responses, as shown 
below. 

 

Figure 3: Ping Test 

Configure a Hardware System with Multiple Modules 

Please refer to the chapter 错误！未找到引用源。, when a system uses multiple 
ront-end modules. This may require special knowledge of the network settings.  

Running EDM 

You are now ready to launch EDM. This section will explain the basics of 
configuring a system, running a test, and saving data. 

Select Spider Real-Time Working Mode 

Make sure EDM is in Spider Working Mode. To change the working mode, use the 
Working Mode item either under the EDM menu in the upper left corner of the 
screen or under the Tools menu, depending on the current working mode. 

 

Figure 4: EDM Working Mode Selection 

Connect to a Database 

It is necessary to create a database to store and access test configuration data. When 
you first open EDM, the Database Access Wizard will be displayed. Select Create a 
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New Database to create a new empty database. Click on the Next button, enter a 
new database name, and click the Create button. Then, click the Access button after 
the database has been created. 

 

Figure 5: Database Access 

 

There are two password controls in the EDM software. One 
password accesses the database server and the other 
password logs into EDM as a user. The database password 
is rarely used.  
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Figure 6: Create New Database 

Alternatively, to open an existing database, select Switch to another database and in 
the next window select the database to use. 

 

  Figure 7: Switch to Another Database 

Configuring a System 

A data acquisition or controller system can be configured from any combination of 
available front-end modules connected to the LAN. The desktop software can store 
multiple configurations and recall any one of them for a test. 

When all of the front-end modules have been connected, bring up the hardware 
configuration window by clicking on Spider Config, or Tools->Spider 
Configuration. 

 

Detected and previously used modules will be listed on the left side by IP address 
and serial number. The top right section shows the modules in the currently 
selected system, and the section below lists settings for the selected module. To 
create a new system, click the Create a New Spider System button on the bottom left, 
enter a name for the system, and select the module or modules to include. 
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Figure 8: Spider System Configuration 

Updating Firmware 

All front-end devices should be kept up to date with the latest firmware to ensure 
the best operation. The desktop software will automatically detect and update the 
firmware on connected modules. To manually update or change the firmware on a 
device, contact a Crystal Instruments tech support engineer at +1-408-986-8880. 

Creating a New Test 

Once the front-end system has been configured and connected, a test can be set up 
by clicking on New Test. 

 

Figure 9: New Test 

Click on Config to access test configuration parameters. 
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Figure 10: Test Configuration 

The test configuration area is a multiple-tab dialog box that allows the user to set up 
the analysis parameters, run schedule, event-action rules and other settings. Some 
of these parameters can also be set directly on the control panel while a test is 
running.  

 

Figure 11. Test Configuration 

 

A test can be controlled by the buttons on the Control Panel and on the Control 
Toolbar. 
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Figure 12: Test Control Panel 

Saving Signals and Recording Time Streams 

Different options are available to save measurement data. EDM uses the terms 
Save for block data and Record for time stream data. Blocks of data, which 
include time-domain and frequency domain blocks, can be manually saved by 
clicking the Save Sigs button or automatically captured based on a trigger setting. 
Time stream data can be recorded manually by pressing the Rec.button or by using 
a run schedule. Data can be stored on the internal flash memory of the front-end 
device or on a hard drive connected to the PC. 

To select which signals to save or record, click on Setup->Measured Signals. 
Under this tab, signals are organized according to their type; each signal can save or 
record. 



 

22 Crystal Instruments Spider-20/20E Manual 

 

Figure 13: Signal Setup 

The signals checked in the Save List column (below) can be automatically saved 
when the user presses the Save Sig button on the control panel, or when an Event-
Action Rule generates a Save Signal action. Currently displayed signals can also be 
saved by pressing Ctrl+S or by clicking on the small disk icon on the top of the 
window. 

 

Figure 14: All Signals Setup 

 

Figure 15: Save Signal Frame to File 
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View Live Signals 

To view a live signal, find it from the list of available live signals on the left side in 
EDM. Right-click the signal and select Display in New Window. 

 

  Figure 16: Signal Display Options 

You can also select View->New Window. This brings up the Window Customizer 
dialog box where you can select which signals to display and which type of display 
window to use. 
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Figure 17:.New Signal Display Window 

Run Folders 
 

Every time the user presses the Run button on the Control Panel, a Run folder is 
created on the disk by default. Data files and a runlog are saved in the Run folder.  
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To save all the data files into one single folder, right-click on the Run Folders pane 
and select ―Use this Run folder for all Runs‖.  

 

A Run folder can be opened, renamed or exported. When a Run Folder is exported, 
all of the data files in the Run Folder will be copied to the target folder. 



 

26 Crystal Instruments Spider-20/20E Manual 

View Saved Data 

Saved signals for the current test are shown under the Run Folders tab on the left 
of the screen. Right-click on any listed signal to display it. 

 

Figure 18: Signal Display Settings 

To view the data files saved by other tests, click on the Data Files tab and browse the 
folder:  
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Create a Report 

Click on the Report tab. Much information as listed below can be generated in a 
report in WORD document. Defined Template feature has many templates that 
were previously defined to generate the report, or the user can customize his/her 
own ones. 

 

Figure 19: Create a Report 

Where is My Data? 

The testing data is managed by the CPU on the front-end hardware and PC (or, 
iPad and other peripherals). The testing configuration and testing results, i.e. the 
measured signals, can be saved in various locations, summarized with the following 
diagram:  
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PC Hard disk

Test 1

Test 2

Test 3 Run1

Run2

Run3

Sig1

Sig2

Sig3

Database keeps all test setup 
history and final snapshot of signals

Hardware Front End

Test 1

Test 2
Test 3

 

 

On the PC the database keeps all the history, testing setup, and the final snap shot 
of measured signals.If you want to backup the setup of ALL tests, simply backup or 
export the complete database. 

The testing data is organized with hierarchy of Tests>Runs >Measured Signals.  

On the PC hard disk, a test folder containing multiple RUN folders is also created.A 
test project file, *.STK, is a copy of the test setup in the database with the 
same test name. It is a single file andcan be easily transported to another PC. 

The Run folders keep multiple measured signals saved by the user or the test. These 
measured signals are not stored in the database.  

Each file of Measured Signals contains multiple signals that are captured at one 
time. We call these signals collectively a frame of data. 

If the user sets the Front-End to black box mode or selects to save the Measured 
Signals to the Front-End instead of the PC, the measured signals will be saved to the 
front-end hardware instead of the PC. Users can always download the measured 
data from the Front-End to the PC. 

On the front-end hardware, the most recent dozen tests are kept in the flash 
memory so the hardware can run without the PC. If operated with the PC, the 
software will automatically synchronize the test configuration from the PC to the 
Front-End.  
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Front-End Hardware 

Overview 

Crystal Instruments currently have several products that are network based – 
Spider-20, Spider-80X, Spider-80SG, and Spider 81/81A/81B/81C. Each product is 
designed by state-of-art technology to meet various needs. The Spider-80SG 
hardware is not included in this chapter but is described in detail in Strain 
Measurement and Analysis chapter. 

Spider-20 

 Spider-20 is a compact yet powerful digital data recorder and dynamic signal 
analyzer. It provides four 24-bit precise high-fidelity input channels, and a unique 
software-selectable tachometer-input/signal-source output channel (all using 
conventional BNC connectors). Each input is individually programmable to accept 
AC or DC voltage or output from an IEPE (ICP) sensor with built-in electronics.  

Spider-20 is a diminutive 5.3 x 4.3 x 1 inch tool weighing only 18 ounces. It has only 
three push-button controls and five LED status indicators. This little powerhouse 
can run over 6 hours on its internal rechargeable battery which can be replaced in 
field with a backup battery. It can also record data on its built-in 4GB flash memory 
at the simple push of a button.  

Spider-20 communicates with the world through its built-in Wi-Fi interface. Use 
your iPad to setup and view or record time histories as well as perform spectrum 
analysis or measure Frequency Response and Coherence functions. Link the 
Spider-20 to your laptop or tablet running Windows and enjoy the full repertoire of 
functionality provided by our EDM (Engineering Data Management) software 
including 1/nth Octave acoustic functions, Order Tracking for rotating machinery, 
Shock Response Spectra for drop testing, or Digital Filtering for special purpose 
analysis.  

Transfer measured data to truly massive storage space using the EDM Cloud 
server. EDM can be used to program your Spider-20 to perform a custom 
measurement or measurement sequence at the touch of its START button, 
making it an unintimidating and user-friendly tool. No computer, tablet or 
phone is required; just use your thumb and Spider-20 operating in Black Box 
mode. Use our flexible Automated Schedule and Limiting software to turn this 
Spider into an intelligent unattended monitor capable of responding to data 
conditions or networked instructions, notifying you of significant conditions via 
e-mail. 

Spider-80X 

The Spider-80X is a highly modular, truly distributed, scalable dynamic 
measurement system introduced by Crystal Instruments. The Spider-80X is ideal 
for a wide range of industries including automotive, aviation, aerospace, electronics 
and military; industries requiring vibration testing and condition monitoring. The 
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Spider-80X excels in industries that demand quick and accurate data recording in 
addition to real-time signal processing. 

Multiple Spider front-ends can be combined to form a single high channel system. 
The Spider system can be arranged with various Spider front-ends and network 
switches to form different configurations. With multiple Spider-80X front-ends, a 
Spider system can have up to 64 input channels in a chassis and chained up to 
hundreds of channels, all sampled simultaneously. Even higher channel systems 
are possible. Multiple Spider front-ends are accurately synchronized through the 
IEEE 1588v2 protocol, making sure all measurement channels are on the same 
time base. Accurate time synchronization results in excellent phase match in the 
frequency domain between all channels, either on the same Spider front-end or 
across different front-ends. Channel phase match, even between separate Spider 
front-ends, is within 1.0 degree at 20 kHz which is suitable for high quality 
structural and acoustics applications requiring cross channel measurement. 

Spider-80X front-ends have voltage, IEPE, and optional charge types of input, 
which are ideal for shock, vibration, acoustic, or general purpose voltage 
measurements. Each Spider-80X front-end is equipped with 8 input channels and 
can accurately measure and record both dynamic and static signals. The mass flash 
memory can record 8 channels of streaming signals simultaneously at up to 102.4 
kHz while computing real-time time and frequency based functions. Two output 
channels provide various signal output waveforms that are synchronized with the 
input sampling rate. Two tachometers sharing the connectors with outputs allow 
the system to measure the rotating pulse signals and conduct order tracking. 

The Spider-80X front-ends can be controlled by a host PC or run in Black Box 
mode where a preprogrammed schedule is uploaded to the unit and started 
manually or based on event triggers. The ability to use any front-end in Black Box 
mode or in a distributed network system means that the user can place front-ends 
close to the measurement object, minimizing cable length and decreasing setup 
time. There is a built-in isolated digital I/O to interface with other hardware. 

Spider-81/81A/81B/81C 

The Spider-81 series is a highly modular, distributed, scalable vibration control 
system developed by Crystal Instruments. It represents the fourth generation of 
vibration control systems with advanced technology unavailable in the current 
generation. 

Unlike traditional controllers that rely heavily on an external computer for real-
time operations, the Spider-81 is the first controller that directly integrates time-
synchronized Ethernet connectivity with embedded DSP technology. This greatly 
increases the control performance, system reliability, and failure protection of the 
controller. It also allows a large number of channels to be configured without 
sacrificing system performance. 
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The Spider-81 hardware modules have voltage, charge, and IEPE inputs which are 
ideal for shock, vibration, and acoustic measurement or general purpose voltage 
measurement. The internal flash memory stores test configuration data for 
controlling up to hundreds of channels simultaneously and stores real-time analysis 
data. Multiple output channels provide various signal output waveforms that are 
synchronized with the input sampling rate. A bright LCD displays testing status 
information. Ten monitoring connections on each unit are used to read signals of 
analog input and output. The front panel has intuitive function buttons. There is a 
built-in isolated digital I/O to interface with other hardware. 

Ethernet connectivity allows the Spider-81 to be located far from the host PC. This 
distributed structure greatly reduces noise and electrical interference in the system. 
One PC monitors and controls multiple controllers over the network. Since the 
control processing and data recording are executed locally inside the controller, the 
network connection does not affect control reliability. With wireless network 
routers, a PC connects easily to the Spider-81 remotely via Wi-Fi. 

The Spider-81 is built on IEEE 1588 PTP time synchronization technology (PTP-
Precision Time Protocol). Spider-81 modules on the same network can be 
synchronized with up to 100 ns accuracy, which guarantees ±1 degree cross channel 
phase match up to 20 kHz. With such unique technology and high-speed Ethernet 
data transfer, the distributed components on the network truly act as one integrated 
system. 

The Spider-81 in Black Box mode enables operation without a PC. In this mode, a 
PC is used only to configure the control system before the system starts operation 
and to download data after the test is completed. During the test, the controller 
operates according to a preset schedule or from a connected iPad. Black Box mode 
is included with every Spider-81/81B. 

For hardware with version 5.8 and lower, up to 4 tests are uploaded and stored on 
each module. For hardware with version 7.3 and higher, up to 8 tests are uploaded 
and stored on each module. 

Each Spider-81 is equipped with a bright front-panel LCD that displays system 
status and test information. Real-time status such as control RMS or sweeping 
frequency is instantly viewed on the LCD. 

The Spider-81 is the very first vibration control system designed for fail-safe 
operation even in the event of network or power loss. Advanced safety routines 
allow sensor failures to be detected within milliseconds. All Spider-81 hardware 
passes strict environmental tests including EMI, temperature, drop shock, sine and 
random vibration. The system is built to withstand the rigors of the testing 
environment with long-lasting durability. The unique floating ground design 
reduces ground loop problems typically found in testing laboratories. A power-
backup circuitry based on super-capacitor is installed to prevent the unexpected 
power loss. 
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Using a patented dual parallel A/D design, the Spider-81 is the first vibration 
control system that achieves 150 dBFS input dynamic range. Each measurement 
channel can detect signals as small as 6 μV and as large as 20 V. This design 
completely eliminates the need for the input range or gain settings found on 
traditional controllers. 

The Spider-81A 16-input version is designed to be a compact system. It integrates 
two Spider-81 modules and a switch. However, the system cannot be expanded 
beyond 16 inputs and does not support Black Box mode or Spider-NAS. 

The Spider-81B is designed to meet the requirements of basic vibration testing 
applications. It has 4 inputs, 1 output, and 4 pairs of digital I/O. 

The Spider-81C member has a Wi-Fi router built-in so that the iPad can access the 
hardware directly. It has 2 analog inputs, 1 analog output, and 4 pairs of digital I/O. 
The control processing and data recording are executed locally inside the controller. 
The network connection does not affect control reliability. 

Unlike traditional controllers that rely heavily on an external computer for real-
time operations, the Spider-81C is the first controller that directly integrates the Wi-
Fi connectivity with embedded DSP technology. This greatly increases the control 
performance, system reliability, and failure protection of the controller. The Spider-
81C hardware modules have voltage, charge, and IEPE inputs which are ideal for 
shock, vibration, and FFT measurement or general purpose voltage measurement. 
The internal flash memory stores test configuration data for real time control and 
stores real-time analysis data simultaneously. 

The Spider-81C is a vibration control system designed for fail-safe operation even in 
the event of network or power loss. Advanced safety routines allow sensor failures 
to be detected within milliseconds. All Spider hardware passes strict environmental 
tests including EMI, temperature, drop shock, sine and random vibration. The 
system is built to withstand the rigors of the testing environment with long-lasting 
durability. A power-backup circuitry based on super-capacitor is installed to 
prevent the unexpected power loss. 

Here‘s a comparison table of all members of the Spider-81 family. For the full 
hardware specification of each product, please refer to the hardware specification 
sheets. 

 Spider-81 Spider-81A Spider-81B Spider-81C 

Number of Input 
Channels 

4, 6, 8 and 
expandable to 

512 

16 not-
expandable 

2, 4 2 

Number of 
Output Channels 

4 4 1 1 
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Input Mode Charge 

TEDS 

IEPE 

AC-Differential 

DC-Differential 

AC-Single End 

DC-Single End 

Charge 

TEDS 

IEPE 

AC-Differential 

DC-Differential 

AC-Single End 

DC-Single End 

Charge 

TEDS 

IEPE 

AC-Differential 

DC-Differential 

AC-Single End 

DC-Single End 

Charge 

TEDS 

IEPE 

AC-Differential 

DC-Differential 

AC-Single End 

DC-Single End 

Digital I/O 8 in/out, 
isolated 

8 in/out, 
isolated 

4 in/out, 
isolated 

4 in/out, 
isolated 

Backup Super 
Capacitor  

Yes Yes Yes Yes 

Available 
Software Bundles 

Silver, Gold Silver, Gold Bronze, Silver, 
Gold 

EDM App 

Front Panel LCD Yes Yes No No 

High Speed Data 
Port for direct 
data recording to 
Spider-NAS 

Yes No No No 

Analog Monitor 
Channels 

Yes Yes No No 

Built-in Wi-Fi 
router 

No No No Yes 
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Input Connections 

 

Unlike the Spider-80X and the Spider-81 family, for its ultra-portability and 
wireless features, the Spider-20 has its unique input connection design.  It has 4 
analog input channels with isolated BNC connector. And the input range is ±10 V 
with single-ended and IEPE input type. 

 

Figure 20. Spider-20 Input Channels 

The input channels of Spider-80X and Spider-81 family are very similar in 
hardware design except the number of channels. Typically, the Spider-80X and the 
Spider-81 family have 2~16 analog input channels with isolated BNC connector. 
And the input range is ±20 V with single-ended, differential, IEPE, Charge Mode, 
and TEDS input type. 

 

Figure 21: Spider-80X Input Channels 

The block diagram for the inputs is shown above. The input chain has a number of 
components that switch in or out of the signal path. There is a calibration circuit 
used for internal calibration (see the separate Calibration Manual). There is also a 
charge amplifier and an IEPE power supply.  

The front-end amplifier operates in single-ended or differential mode. In single-
ended mode, the shield on the input jack is grounded, and the measured input 
voltage is referenced to this ground. In differential mode, the shield is not grounded 
and the measured input voltage is the potential difference between the shield and 
center terminal. After this initial amplification stage, there is an analogue high-pass 
filter for DC removal that is switched on only in AC input modes. After that, there is 
the final analog amplification stage, the Analog to Digital Converter, and the DSP 
processor. 
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The rest of the signal processing is done by the Digital Signal Processing (DSP) 
microprocessor. This processor specializes in the floating-point arithmetic used to 
process the input signal and generate an output.  

The Spider-20 uses traditional multi-stage amplifiers in each input channel. It does 
not have charge mode and TEDS detection. The Spider-80x and Spider-81 series 
have charge mode as well as TEDS detection. They also adopt the patented dual 
A/D technology to achieve extremely high input dynamic range. A block diagram of 
such front-end is shown below.  

Cal Circuit

Analog Input

Charge Circuit
TEDS 

Detection IEPE Power

ADC

DSP

Amplifier
With GAIN 1

AC HP Filter
or 
DC

Single-
End or 

Diff.

ADC
Amplifier

With GAIN 2

 

 

Figure 22: Typical Input Block Diagram (Spider-80x and Spider-81) 

 

 

Figure 23: Single-Ended vs. Differential input 

Vcc

Input 
Terminals

+

-

Vin

Input Amp

Single-Ended
Vcc

Input
Terminals

+

-

Vin

Differential

Input Amp
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There are six modes in which the inputs can operate for the Spider-80X and the 
Spider-81 family. The Spider-20 only has DC-single end, AC-single end, and IEPE 
modes. 

DC-Differential 

In DC-Differential mode, neither of the input connections is referenced to the local 
ground. The input is taken as the potential difference between the two input 
terminals, and any potential in common with both terminals is canceled out. The 
Common Mode Voltage (CMV) will be rejected as long as the overall input voltage 
level does not saturate the input gain stage. Beware that very high CMV will cause 
clipping and may damage the input circuitry. Signals with a non-zero mean (DC 
component) can be measured in this mode. 

DC-Single End 

In single-ended mode, one of the input terminals is grounded and the input is taken 
as the potential difference of the center terminal with respect to this ground. Use 
this mode when the input needs to be grounded to reduce EMI noise or static 
buildup. Do not use this mode when the signal source is ground referenced or 
ground loop interference may result (see the Grounding section below). This mode 
also allows signals with a non-zero mean to be measured. 

AC-Differential 

AC-Differential is a differential input mode that applies a low frequency high-pass 
(DC-blocking) analog filter to the input. It rejects common mode signals and DC 
components in the input signal. Use this when DC and low frequency AC voltage 
measurements are not required or when a DC bias voltage is present. The analog 
high-pass filter has a cutoff frequency of -3dB at 0.3 Hz, and -0.1dB at 0.7 Hz. 
Figure 24 shows the shape of the filter.  

AC-Single End 

AC-Single End grounds one of the input terminals and enables the DC-blocking 
analogue filter. Use this mode for non-ground referenced sources where measuring 
the DC or low-frequency components is not required. AC-Single End shares the 
same high-pass filter as AC-Differential. 

When either of the AC input modes is used, there is also a digital high-pass filter, 
implemented in the DSP, with a user-definable cutoff frequency. Note that the 
analog high-pass filter is always active, even if 0 is set as the cut-off frequency for 
the digital filter. 
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Figure 24: AC Input Mode High-Pass Filter Shape 

IEPE (ICP) 

All Crystal Instruments products support IEPE (Integral Electronic PiezoElectric) 
constant current output type input channels. IEPE refers to a class of transducers 
that are packaged with built-in voltage amplifiers powered by a constant current. 
These circuits are powered by a 4 mA constant current source at roughly 21 Volts.  

IEPE accelerometers are available under several different brands including ICP® 

(PCB Piezotronics), Isotron® (Endevco), CCLD or Delta-Tron® (B&K), and 
Piezotron® (Kistler). 

IEPE sensors are rarely used to measure DC or very low frequency signals. This is 
rarely a problem when measuring acceleration in dynamic tests. The IEPE input 
mode has the analog high-pass filter enabled with a cutoff of -3dB at 0.3 Hz and -
0.1dB at 0.7 Hz. 

Charge Mode 

Some sensors provide a high-impedance charge output. Usually, these are high-
sensitivity piezoelectric units that lack a built-in voltage mode amplifier (i.e. IEPE), 
allowing them to be used in high-temperature environments. The Spider front-end 
module has a built-in charge amplifier that allows the system to read the output of 
these sensors. 

The charge amplifier in the Spider converts the charge sensor output in 
picoCoulumbs (pC) to a voltage in millivolts (mA), which is then input to the ADC. 
The sensitivity parameter in the software Input Settings sets the composite 
sensitivity from sensor output to engineering unit, so this process is transparent to 
the user. The analog high-pass filter has a cut-off of -3dB at 0.3 Hz and -0.1dB at 0.7 
Hz. 
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For the Spider-80X, the input range is 40,000 pC. For the Spider-81 series, there 
are two gain settings in the charge channel, one with full range of 10,000pC and the 
other 49,000pC. Similar to that of voltage input mode, the user should try to 
maximize the input range of charge signals while making sure no overload will 
happen. In other words, choose a charge sensor with higher sensitivity in order to 
achieve the best measurement results.  

All versions of the Spider-81 are equipped with charge inputs. The charge amplifier 
is not available on the version 5.8 and older Spider-81B. It is available on version 
7.x of Spider-81B.  

Using an In-Line Charge Converter 

An In-Line Charge Converter is an external device designed to convert the high-
impedance source of a charge mode piezoelectric transducer to a low-impedance 
voltage signal by means of an ICP ® powered signal conditioner. These units may 
be used with either quartz or ceramic charge-mode piezoelectric sensors. 

 

  Figure 25: The Charge Converter 

When using a charge-mode sensor connected to an inline charge converter, use the 
In-Line Charge mode. 

Notice that some in-line charge converters change the polarity of the signal. Do 
some initial testing to verify this before running a shaker test. 

TEDS 

The IEEE P1451.4 "Standard for smart transducer interface for mixed mode sensors 
and actuators" describes a mixed-mode communication protocol based on existing 
analog connections. Mixed-mode means that both analog and digital signals are 
sent over a single coaxial cable. IEEE P1451.4 also specifies the Transducer 
Electronic Data Sheets (TEDS) format where transducer-specific digital 
information such as transducer identification, sensitivity, location, calibration 
values, and other parametric data can be stored.  

Front-end hardware that can communicate with TEDS sensor scan read the digital 
data from the sensors and automatically configure the input settings. The Spider 
systems can use TEDS to automatically import the measurement quantity and 
sensitivity of connected sensors. 
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Figure 26: IEPE and TEDS Circuitry 

Choosing the Correct Input Coupling 

Accelerometers and other sensors that require the IEPE current source must have 
that mode enabled to operate properly. Note that the analog high-pass filter is 
enabled when IEPE is on, so measurements below 1 Hz cannot be made with these 
sensors.  

For other types of sensors, measurements below 1 Hz are possible with the DC 
coupling modes. It is recommended that the control sensors in Shock tests use DC 
coupling. 

The single-ended modes, which include IEPE, should be adequate for most 
situations, and are best for EMI noise rejection. However, if a non-IEPE sensor is 
used, and a ground loop problem occurs, then the input mode should be switched 
to differential. If a differential input mode cannot be used, then the ground of the 
controller should be tied to the sensor with a low-impedance conductor. 

Matching Sensor Sensitivity to the Input Range 

A special technique is used in CI products to achieve a very high dynamic range in 
the input channels. This patented technology uses two A/D converters for each 
input channel to achieve 130 to 150dB dynamic range. Refer to the 130dB Dynamic 
Range CI whitepaper for more details. 

With this technology, there is no need for multiple input range settings and 
measurements can be made over the entire range from a few microvolts to 20 volts. 
However, signal outputs from sensors should be as large as possible without 
overloading the input channels to maximize the signal to noise ratio. Too large of an 
input will cause clipping and distortion. 

Do not exceed the input range stated in the specifications, usually ±20 V. For 
example, if you are doing a vibration measurement estimated to be 10 g RMS and 
the peak value of the test is assumed to go 5 times its RMS level, the sensitivity of 
the sensor should be smaller than 20V/50g-peak = 400 mV/g.  

Choosing a sensor with too low sensitivity will cause the signals to be buried in 
noise. In the example above, if you choose a 4 mV/g sensor, the useful signal will be 
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100 times lower. The effect of noise sources such as EMI and ground loops will be 
much greater and the data will be unusable. 

For charge input, the two ranges are 10,000pC and 49,000pC. For example, if the 
full charge range is 10,000 pC, you should choose a sensor that generates less than 
10,000 pC with the expected peak excitation. But the signal should not be too small 
as to be buried in the noise.  

Power Connection 

The Spider-20 is powered by an interchangeable battery with DC charger interface. 
The fully charged brand new battery lasts at least 6 hours in full operation. The 
lithium battery has the limited life span and should be replaced at certain time. 

 

The Spider-80X and the Spider-81 family require an external power 
provided through the wall-mount AC/DC adapter. The output of the 
DC adapter, which is rated 15V/3A, should be connected to the DC 
connector on the rear of the front-end device. They have an internal 
backup power supply that will provide at least 8 seconds of powerto 
save data and shut down the system in case of a power loss. This backup power 
source cannot run the system for any longer length of time. 

Digital I/O 

 Spider-

81 

Spider-

80X 

Spider-

81A 

Spider-

81B 

Spider-

81C 

Spider-

20/20E 

Digital 

I/O 

8 in/out, 
isolated 

4 in/out, 
isolated 

8 in/out, 
isolated 

4 in/out, 
isolated 

4 in/out, 
isolated 

Not 
equipped 

 

The Spider-81 and Spider-81A have the identical Digital I/O design. The Spider-81B 
and Spider-81C also have this same design but have the reduced number of input 
and output. The 12V power supply pin is also removed for the Spider-81B and 
Spider-81C.  

If the system is composed of multiple Spider-81 modules, only the master module 
can use the Digital I/O features. Each Spider-81, as well as the Spider-81A, has 8 
isolated digital inputs and 8 digital outputs, corresponding to the pins on the Digital 
I/O connector. A digital input is detected when a low-high-low voltage change 
occurs, which triggers the event actions set in the Event Action Rules section of the 
Test Configuration window. Any device that can output square voltage pulses can 
communicate with the data acquisition/controller system. 
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Pin Assignments 

The DIO interface of the Spider-81/81A/81B/81C uses a DB-25 female connector. 
The pins for OUT5~8, IN5~8, and +12V remain unused on Spider-81B/81C 
hardware. 

The DIO interface of the Spider-80X uses a DB-15 female connector. 

 

Figure 27: Spider-81 Series Pin Assignments of DIO Interface Connecter 

 

Figure 28. Spider-80X Pin Assignments of DIO Interface Connector 
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Figure 29. Spider-81B/81C Pin Assignments of DIO Interface Connector 

 

Pin name Pin number Pin Description 

OUT1 – OUT4 1, 2, 3, 4 
8 output signal pins. Connect these pins 
to the input signal pins of the external 
device. 

IN1 – IN4 5, 6, 7, 8 
8 input signal pins. Connect output 
signals from the external device to these 
pins.  

+3.3V 15 
+3.3V power supply (for internal use 
only) 

+12V 13 +12V power supply 

GND 10, 12 Digital ground 

EX_GND 14 
External ground for isolated external 
devices 

EX_PWR 9, 11 
External power, usually +12 V, 
reference ground is EX_GND. 

 Table 1: Spider-80X DIO Port Pin Description 
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Pin name Pin number Pin Description 

OUT1 - OUT8 1, 2, 3, 4, 5, 6, 7, 8 
4 output signal pins. Connect these pins 
to the input signal pins of the external 
device. 

IN1 - IN8 9, 14, 15, 16, 17, 18, 19, 20 
8 input signal pins. Connect output 
signals from the external device to these 
pins.  

+3.3V 13, 25 
+3.3V power supply (for internal use 
only) 

+12V 10 +12V power supply 

GND 11, 23 Digital ground 

EX_GND 12, 24 
External ground for isolated external 
devices 

EX_PWR 21, 22 
External power, usually +12 V, 
reference ground is EX_GND. 

 Table 1: Spider-81 Family DIO Port Pin Description 

The digital inputs are opto-isolated and take a 12 V signal. The output device must 
supply the voltage. The circuit is shown in the figure below. 

VCC

EX_GND

EX_PWR

Input pin

Spider81

Switch

Switch

External power 
supply 12VDC

Input pin

External device

Optocoupler

Optocoupler

Logic input

Logic input

VCC

 

Figure 30. Input Circuit 

The figure below shows an example of connecting a push-button switch to an input. 
When the switch is ON, the corresponding input bit is 0, and when the switch is 
OFF, the input bit is 1. Momentarily depressing the switch will trigger an input 
event in the channel. RL should not be greater than 6 kΩ. 
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Figure 31. Switch connection to input 

Output Circuit 

The output channels can be connected to a current driven device such as a relay or 
LED. They are opto-isolated, open-collector outputs, but require an external voltage 
source. 

EX_GND
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Output pin

Spider81

External power 
supply 12VDC

External device

Optocoupler

OptocouplerLogic output

Logic output

VCC

Output pin

Load1

Load2

 

Figure 32. Output Circuit 

The maximum rated output current per channel is 60 mA.The output section uses a 
low-saturated transistor foroutput so it can be connected to a TTL-level input. 
Figure 32 shows an example of a connection to an external LED. The LED will 
illuminate when the output bit is 0. 



 

45 Crystal Instruments Spider-20/20E Manual 

EX_PWR

Output pin

EX_GNDS
p

id
er

8
1
 D

IO
 P

o
rt

+3.3V/+12V

GND

RL

1K ohm

 

Figure 33. Output Connection to LED 

DIO Setting 

Digital output is initialized when the system is booted up. The digital output pins 
follow the initialization mode. For example, if output pin #03 is set to Low-High, 
when the system starts up, the pin #03 will send Low-High output. 

 

In Spider-80X, there is an input/output flipping feature. Check the input or output 
pin box(es) and click << or >> to switch input pins to output pins or switch output 
pins to input pins. In all other Spider platform, this feature is grayed out 

Programming the DIO 

A digital output is sent when a digital output action is triggered by an event in the 
Event Action Rules. The output signal can be set as a pulse or a step in the negative 
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or positive direction. Any device that can read such a voltage signal can then be 
controlled by the data acquisition/controller system. 

The programming of digital input and output is on the Digital IO Setup tab of 
Testing Configuration dialog box. 

To activate a test using a digital input signal, check one of the listed digital input 
pins and click on the Set Run Test Pin button. 

The digital output default state is set to be used by Send Digital Output Signals 
event. Refer to Event Action Rules chapter for more details about this event. 

The state of the digital inputs and outputs can be displayed with the Digital I/O 
View in the View->Digital I/O tab in EDM.  

 

Figure 34. Digital I/O Window 

 

 

 

Basic EDM User Interface 

EDM, or Engineering Data Management, is the desktop software that works with all 
Crystal Instruments front-end hardware. 
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Working Modes 

EDM has 3 working modes: CoCo Dynamic Signal Analyzer (DSA) mode, CoCo 
Vibration Data Collector (VDC) mode, and Spider real-time mode. The Spider real-
time mode includes the Dynamic Signal Analyzer (DSA) real-time operation and 
the Vibration Control System (VCS) operation. The Spider DSA only works under 
Spider Real-Time Mode. 

There is also a Simulation Mode under Real Time Mode. The Simulation Mode 
allows the user to run a set of recorded or simulated data without connecting to any 
actual Front-End.  

To switch between CoCo working modes, use the Switch Working Mode option 
under the Tools tab in CoCo mode. 

 

Figure 35: Working Mode Selection 

 

When EDM starts up in real-time working mode, it presents a Start Page from 
which a recent test can be opened, previous tests can be searched through and new 
tests can be created. This is a convenient starting point for most EDM operations. 
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Figure 36: EDM Start Page 

The start page has four sections: Recent Tests, which allows quick access to recently 
used tests; Create a New Test, for creating a new test of the selected type; Account 
Login to change the current user account; and Connection Status which lists all 
detected front-end devices on the network. There is also a Search button to find a 
specific test in the database. 

If the License Key only enables the Spider function, then the only available test 
option will be the FFT Spectral Analysis. 

The Spider real-time mode uses a traditional menu and toolbar interface. The 
toolbars allow quick access to the most common commands, while the menus 
provide a more complete catalog of EDM commands, organized by function. There 
are 7 toolbars, corresponding to the 7 menus. To change which toolbars are 
displayed, select Toolbars under the Hide/Show button on the upper right corner. 
Toolbars can be rearranged by clicking and dragging their left edge to the desired 
location. 
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Figure 37: Toolbar Setting 

 

Menus in EDM Real-Time Mode 

The available menus are Test, Setup, Control, View, Layout, Tools, Report, 
and Help. 

Test Menu 

This menu is for creating, opening, saving, and configuring tests. A test is a 
collection of configuration settings and acquired data. Each test operates in one 
mode, such as Random Control, Swept Sine Control, or Dynamic Signal Analysis. 
By default, EDM stores the test data, i.e. signals, in the Run Folder in ATFX format. 
The measured data can be also saved to the internal flash memory in the front-end 
hardware if the user chooses.  

 

Figure 38: Test Tab 
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New Test starts the New Test dialog box and allows the user create a new test 
based on manufacturing settings or a preconfigured test template. 

Open Test allows the user to open an existing test from the database or browse the 
test file from the disk.  If the user opens a test file on the disk that has a duplicated 
name in the database, the software will prompt a message asking the user if he 
wants to load the test and overwrite the one existing in the database.  

Save Test will save the changes to the database. When EDM exits, the contents of 
database will be automatically synchronized to the testing file on the disk. In other 
words, the test will always be saved. All changes that you made will be saved. 

Save Test As saves a test to a different name. 

Delete Test willdelete the test file from the database and the disk. It will ask the 
user if he wants to delete associated data files.  

Lock Test will lock the test in the database so it cannot be accidentally deleted. A 
locked test can be unlocked later. 

Pin Test will show this test in the test pane until it is unpinned.  

Export Run Folder will export all signals from the current run folder to a 
directory. 

Open Data File will let the user browse from the disk and open a data file.  

Check List opens the summary of critical parameters for review. This dialog box 
can be prompted before each test if the user so chooses. 

Run History opens a dialog box to show recent runs in various categories. It is the 
best way to look at prior tests in chronological order. 

Import LDS Project allows users to upload an LDS test project to the current 
EDM test. (See the Import LDS Project section for details) 

Account Logout will let the user log out from his/her current account. 

Exit EDM will exit the software. If a test is still in progress, the software will ask 
the user to stop the test first then exit. When EDM exits, all changes to all of the 
tests will be automatically saved.  

Setup Menu 

This menu is used to setup all test related parameters such as channel tables, 
test configurations, and black-box mode. 
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Figure 39: Setup Tab 

Test Configuration opens a tabbed dialog box and allows the user to set all of the 
testing parameters. 

Engineering Units allows the user to setup the EU as global parameters, or just 
for the current opened test. 

Input Channels opens the channel setup dialog box. 

Measured Signals opens the measured signal dialog box. The measured signals 
are those signals that can be displayed or stored.  

Test Sequence lets the user set up a number of tests so the software can run them 
one by one. 

 

Figure 40. Example of Test Sequence Setup 
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Black Box Setup allows the user to upload, refresh, or remove the tests from the 
front-end box. A test uploaded to the Spider devices can be run in the black box 
mode and can be accessed by DIO, front panel buttons or an iPad. 

Alarm Limits allowsthe user to bind customized limits on the test. 

Control Menu 

Commands for controlling the test such as: Run, Hold, and Stop, are found under 
the Control Menu. These commands are duplicated on the Control Panel on the 
right side of the screen. There are also commands for recording time streams and 
saving block signals, which can be used even while a test is in Stop mode. 

 

Figure 41: Control Tab 

View Menu 

The View Menu is used to add display windows. Display Windows are windows for 
displaying data under the Signal Display tab(s) in the main EDM window. This data 
can be from recorded files or real-time acquisition, in the time domain or frequency 
domain. EDM provides a set of default windows for displaying the standard data 
types such as time streams, blocks, and frequency spectra. Custom window 
templates, with user-defined combinations of displayed signals, can be defined 
using the Save Active Window as User Defined command. These custom templates 
will be listed in the bottom of this menu. 
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Figure 42: View Tab 

Layout Menu 

The Layout menu has commands for opening and closing signal display tabs. The 
tabs, with their current layout, can also be saved and opened. Each of these tabs 
contains one or more display windows, opened using the View Menu above. There 
are also commands for arranging the display windows in the current tab. 

 

Figure 43: Layout Tab 

Tools Menu 

This menu has commands for general EDM functions. These include hardware 
configuration and calibration, database functions, switching the EDM Working 
Mode, opening the License Manager, and opening the Global Settings window. 
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Figure 44: Tools Tab 

Report Menu 

This menu has the commands to generate all kinds of testing reports including test 
data, parameters, and users‘ notes. 

 

Figure 45: Report Tab 

User Accounts 

EDM has user management features that allow multiple user accounts to be created, 
each with different features enabled. This allows the user interface to be 
personalized for different users, and to control access to different levels of 
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configuration. By default, there are two users defined: the Admin and the Operator. 
The admin has access to every feature and has the ability to edit the privileges of 
other users. The operator only has the basic privileges required to operate but not to 
edit a test. 

When EDM is initially installed, the accounts Admin and Operator have empty 
passwords.  

In the welcome screen when EDM first starts up, there is a section for logging in 
with a user name and password. Once a user has logged in, only the features 
enabled for that user account will be available. Accounts can be set as Administrator 
or Normal User accounts, and only Administrator accounts can change the user 
account settings. 

To edit user accounts, you must be logged in under an administrator account. 
Selecting Account Manage in the Tools menu brings up a dialog window with a 
list of the defined users. On each row, there are links to change the password, 
change the account options, or delete the account. On the bottom of the window, 
there are buttons to add a new account, delete an account, and to duplicate the 
selected account. 

 

Figure 46: EDM Account Manager 

Click on the Options link to edit an account. The Modify Account option window 
that appears allows the password and account type to be changed, and has a list of 
user privileges. For each item in the privileges list, there is an Editable and Viewable 
option. Disabling the Editable option prevents the user from modifying the settings 
for that item, and disabling the Viewable option prevents the user from seeing 
anything related to the item. 
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Figure 47: Account Options 

 

About the License Keys and Evaluation Mode 

EDM requires a license key file to run. This file verifies that the user has purchased 
the software features. A license key is linked to one or more hardware devices by 
serial number. If you try to connect to a device with a serial number not in the 
current license key, an error will be displayed. 

Only one license key file is active at a time. To change the active key, open the 
License Key Manager under the Tools menu. The available license keys are 
listed at the top and information about the selected one is shown in the bottom. 
Double-click a listing to activate it. EDM will have to be restarted for license key 
changes to take effect. If a license key isn‘t listed, but is present on your local 
computer, click Browse New License Key to find it. 
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Figure 48: EDM License Key Management 

The Software Renew Periodis the time period during which the software can be 
upgraded. The Software Activation Periodis the time period during which the 
software is operational and can be used. 

Test groups are activated by the license key. There are two modes of each Test 
group, a fully functional mode and an evaluation mode. They are both controlled by 
the license key. If the fully functional mode of a test group is not activated, tests of 
its type can still be created in evaluation mode. In this mode every feature of the test 
type is available however, the test will only run for 30 seconds, signals cannot be 
recorded or saved and reports cannot be generated. The evaluation mode feature 
allows you to configure and evaluate different test types before purchasing them. 
Once a test is purchased from Crystal Instruments, it can be run without limitations. 

For details about how to activate individual tests in evaluation mode, contact 
Crystal Instruments or your local Crystal Instruments sales rep. 

EDM Global Settings 

The EDM Global Settings under the Tools tab are settings that affect the entire 
EDM environment and interface. These are different from the Test Configuration 
options, which only affect the current project. 
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Figure 49: EDM Global Settings 

Signal Export includes four sub-sections for signal export settings. 

General Properties defines the signal attributes to be included in exported files 
including: spectrum format, window type, window correction mode, energy factor, 
amplitude factor, acquisition/calculation method, amplitude scaling, averaging 
mode (lin/exp averaging time constant), and number of averages. By default all of 
these attributes are exported with the data. These settings only apply to ASCII, 
MatLab and Excel CSV data export formats. The other formats use a predefined list 
of attributes that cannot be modified. 

Text export layout settings are also defined here. The options are to only export Y 
values and to export any X start and step values. 

Common Properties defines additional signal attributes to be exported 
including signal name, sampling rate, block size, X unit, Y unit, and NVH signal 
type. These settings only apply to ASCII, MatLab and Excel CSV data export 
formats. 

Frequency Properties defines additional signal attributes to be exported with 
frequency-domain signals including spectrum format, window type, window 
correction mode, energy factor, amplitude factor, acquisition/calculation method, 
amplitude scaling, averaging mode, lin/exp averaging time constant, and number of 
averages. These settings only apply to ASCII, MatLab and Excel CSV data export 
formats. 
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Spectrum Format defines the default spectrum format when Auto Power 
Spectrum data is exported. 

 

Figure 50: Spectrum Format Setting 

Setting Target selects the signal type that the Spectrum Type and Vertical Axis 
Format settings will affect. The signal types are Auto Power Spectrum, coherence, 
complex spectra, cross power spectrum, and Frequency Response Function.  

Spectrum Type: (EU)2/Hz, (EU)2s/Hz, (EUrms)2, EUpeak, EUrms 

Export Vertical Axis Format: magnitude (Mag) or decibels (dBMag) 

MAT-File Preference defines attributes for the MatLab file export format. 

Default Display Format defines the default display format of the frequency 
spectrum. These settings will be used when a new display window is created in 
EDM.  

Working Folder sets the default working folders for program files and data 
storage. 

DSA Engineering Units sets the engineering units used globally in EDM. The 
engineering unit display setting does not affect the actual values of the signals, only 
how they are displayed and labeled. This setting can be different from the setting on 
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the devices from which the data was acquired. For example, an acceleration signal 
can be acquired in ―g‖ on CoCo while displayed in ―m/s2‖ here. 

Plot Properties define how the time values, signal lines, numeric values, grids, 
and markers are displayed in the display windows where signals are plotted. 

Time Signal AVD Setting stands for Acceleration Velocity Displacement. It is a 
set of filters used in the signal display interface when the AVD signal display 
conversion is in progress. It is for filtering the data when integrating or 
differentiating. The AVD setting can eliminate some aliasing at a certain 
frequencies, and it can make the time stream display more smoothly with reduced 
disturbance.  

Mail Setting defines how EDM sends email per Event Action Rules. SMTP server 
address, port number, encryption type, and authentication parameters are specified 
as required. The Spider hardware (only version 7.x) is also equipped with a send 
email function that can be used when the email server doesn‘t require SSL 
encryption. Sending email through the hardware is not always available when SSL 
encryption is required. This feature enables sending emails in Black Box mode. The 
origin of email, either from the Spider hardware or the EDM, can be chosen from 
the Event Action Rules. 

 

Figure 51: Mail Setting Setup 
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Appearancehas options for the color scheme of the interface, for displaying the 
start window, and for enabling tool tips. 

 

Figure 52: EDM Appearance Setting 

The Default Font size, Small, Medium and Large refer to the font sizes that are 
used in the signal plots and tables.  

The language of the user interface can be changed. EDM currently supports English, 
Simplified Chinese, Traditional Chinese, and Japanese.  
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 Figure 53: Language Setting 

Socket Server (refer to the independent manual of Socket Messages. reserved for 
Spider-81 use.) 

VCS/DSA Settingdefines the following global actions for VCS/DSA tests. 

 

Figure 54: VCS/DSA Setting 

 

System Configuration 

A system consists of one or more front-end modules that operate together. To 
run as a controller system, at least one of the modules must be a Spider-81 or 
Spider-80x, but the others can be any compatible front-end module. Additional 
modules add input channels to the system up to 24 modules with 192 channels. 
When the system is composed of more than one module, only the input channels on 
the master module can be set as trigger source. 

A system is configured from the Spider System Configuration window accessed in 
the Tools menu, Spider Configuration option. 



 

63 Crystal Instruments Spider-20/20E Manual 

 

Figure 55: Spider System Configuration 

On the left side of the window, all detected front-end modules and previously used 
modules are listed. They are named by their IP address and serial number.  

To setup a new system press the Create a new Spider system button. In the window 
that appears, select the module(s) to be included in the system, enter a name for it, 
and press OK. Selecting Set as Default Spider System will make this the default 
system choice in all new tests. 
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Figure 56: Create A New Spider System 

The system will then be displayed on the top pane of the window with a list of the 
included modules. Use the Configured Systems drop-down menu to select other 
systems. The buttons along the top allow the selected system to be renamed, 
deleted, or set as default. There is also a button to generate a report with details 
about the system and associated modules. 
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Figure 57: Spider System Management 

 

Settings for individual modules are changed in the bottom part of the window. 
There are 3 tabs: Hardware Info and Version, IP Setting, and Date and Time Setting. 

 

Figure 58: Spider System IP Setting 

The Hardware Info and Version tab shows hardware information about the module. 
These settings cannot be changed. For security reasons, the module can be assigned 
an Access Code. Once set, EDM must have the same access code configured for it to 
connect. This tab also lists software functions installed as firmware components. 
These components are installed by Crystal Instruments. 
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Figure 59. Spider System Hardware Configuration Setting 

The IP Setting tab sets the IP configuration of the module. It can use DHCP to 
obtain an IP address automatically or a manually configured IP address, subnet 
mask, and default gateway. These are set according to the configuration of the 
network the unit is attached to. 

Note: Whether the DHCP IP address can be used depends on 
whether the network switch has a DHCP server installed.  Only 
fixed static IP addresses can be used with the Spider-HUB 
because it does not have a DHCP server. 

 

The Date and Time tab is used to change the internal clock setting of the module. 

 

Figure 60: System Date and Time 

 

 

Input Channel Settings in EDM 

Typically each Spider unit has 8 inputs, and up to 8 modules can be connected 
together for a total of 64 inputs. Sensors or transducers convert physical quantities, 
such as force, acceleration or displacement to voltages which can then be measured 
by the front-end hardware. The software converts the measured voltages back into 
physical units such as newtons, meters per second squared, or centimeters using a 
sensitivity parameter as the proportionality constant.  

The geometric location where a sensor is affixed to a test article may be described in 
the ID in the Input Channel Setup. An entered description such as ―bearing #1 
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vertical‖ then replaces the default ―Chx‖ label. This ID is shown with the channel 
everywhere it is displayed and with its saved time stream data. For other data 
processed from that time stream, EDM uses a consistent naming convention where 
the data type is followed by the Location ID of the source in parenthesis. The data 
types are Block for Block Data, APS for Auto Power Spectral data and H for the 
Frequency Response Function. For example, the Auto Power Spectrum from 
channel ID ―Point1‖ would be named as ―APS(Point1)‖. 

Input Channel Setup 

In FFT test, inputs are configured under: Setup->Input Channels.  

 

Figure 61: Input Channel Table (FFT) 

On/Off enables or disables the channel. 

Location ID assigns a custom label used to identify the source in the signal display 
and other setup windows. 

Measurement Quantitydefines the physical unit that will be measured by the 
sensor connected to the channel. 

Sensitivity sets the proportionality factor for the measurement (millivolts per 
engineering unit) given as a parameter of the sensor. 

Input mode is the electrical interface mode of the sensor (see above). 

Sensor defines the sensors imported from libraries. 

High-Pass Filter Fc (Hz) sets the digital high-pass filter frequency, used to block 
spurious low frequency and DC signals. To measure very low frequency or DC 
signals set this value to zero and use the DC-SE or the DC-DI input mode.  

Time Weighting defines the time weighting for exponential averaging. (Only 
available in acoustic test) 
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Time Intervalis the time period of calculating Leq for each individual channel. 
(Only available in acoustic test) 

If the Modal Data Acquisition (MDA) function was enabled during the progress of 
creating a new FFT test, Click the MDA button to show the expanded MDA 
definition of each channel‘s input. Provision is made for roaming excitation (impact) 
tests, roving response shaker tests and permanently installed multiple input and/or 
output modal tests.  

 

Figure 62. MDA Parameters in Input Channel Table (FFT) 

In Acoustic Analysis tests there are two additional channel properties, Time 
Weighting and Time Interval as shown below. 

 

Figure 63. Input Channel Table (Acoustic) 

 

On the top of the tab there are a series of buttons used to manage the channel 
settings. Fill allows the settings of one channel to be copied into all the remaining 
channels (Fill All) or only to a range of channels (Fill Range). 
Ex/Im(export/import) allows the current channel list to be saved to a file or a 
previously saved list to be opened and applied. This allows the current settings to be 
saved and applied to future tests. Unit is a shortcut to the DSA Engineering Units 
section of the EDM Settings dialog, allowing the global engineering units to be set. 
The remainder of the tool bar is used for library synchronization (See ―Using 
Libraries‖ below). The channel list shows a number of settings for each channel: 
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Creating FFT Tests 

EDM executes a created or recalled test project. A test project consists of an input 
and output configuration, analysis parameters, and acquired data. A new test is 
created by selecting New Test in the Test menu. This opens the New Test Wizard. 

 

Figure 64: Create a New Test 

Select the type of test on the first page. Dynamic Signal Analyzer (DSA) mode is 
used for data acquisition and analysis. The most general of these is FFT Spectral 
Analysis (selected here) which will be employed for general vibration analysis, 
control system investigations, analog circuit studies and modal analysis among 
others. When required, DSA can provide various types of stimulation signals (up to 
2 per Spider-80X module) including random noise, sinewave and swept sine. 
Depressing Next> advances to the second page. 
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Figure 65: The Wizard for a New Random Test 

The second page allows you to name the test and write a description of its purpose. 
Press Next> to advance to the third page. 
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Figure 66. Signal Types in Real Time 

On the third page in the DSA mode test wizard you enable the various types of 
computed functions that will be employed. These include time histories, computed 
time histories such RMS, Peak and Tachometer RPM, FFT spectra, Averaged Auto 
and Cross Power spectra, Shock Response Spectra and Frequency Response and 
Coherence functions. Pressing Finish> exits the wizard and enters the DSA Test 
screen. 
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Figure 67: A DSA Test 

The DSA Test screen is divided into 5 parts. On the top is the menu and toolbar 
section. On the left side, are the Recent Test List and the Signal List sections. On the 
right are the Test Control section and the Status window. In the middle are the 
Signal Display and Signal Setup tabs. 

Recent Test List 

 

Figure 68: Recent Tests List 

On the upper left part of the screen, the Recent Tests list shows current and 
previous tests. Each test is listed by its name and type (VCS or DSA). Each test entry 
can be expanded to display items related to the test. 
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Systemlists the hardware modules associated with the test. The system is 
set up with the Spider Config window described under System 
Configuration. The name of the system is displayed in parentheses. 

Signal List 

Under the Recent Tests list is the Signal List, which shows live signals and saved 
data available for display in the current Test. 

 

Figure 69:Signal List 

Live Signals include all input channels and the output channel (s) that are 
components of the current system. Depending on the test type, there might also be 
other signals such as the control profile, associated alarm, and abort lines. The list is 
divided into categories for time streams, block signals, and frequency data from 
these sources. It can also be viewed according to the hardware modules by right-
clicking on the list and selecting Sort Signals by Spider Modules. 

Run Folders tab displays the recent Runs: 
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Each time the user presses the Run button and the test finishes, a numbered Run is 
generated. By default, a Run folder is created on the disk. As shown in the picture 
above, for a given test, Random1, a test file, Random1.stk, is created. Each Run in 
the Run Folder tab corresponds to a physical folder on the disk.  

Data Files are time streams and block data saved or recorded to disk. All of the data 
files under a specific Run will be saved into that Run folder. When block signals are 
saved by clicking the Save Sigs button, a data file will be created and displayed 
here. 

 

Figure 70: Data Files Tab 
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Control Panel 

The Control Panel is used to control the test and to display status information in 
real-time. The connection status of the hardware is shown on top with a button to 
Connect/Disconnect (if no hardware is detected, this button will not be displayed). 
The control buttons — Run, Hold, Stop,Save— duplicate the items in the Control 
menu and on the Control toolbar. Config opens the Test Configuration window. 
Rec./Stop starts/stops the recording after test runs. 

Information on the state of the test is displayed below the control buttons. 
Depending on the test mode, this might include the output level (as a percent of the 
test profile) and peak voltage, the control input peak and RMS level, the target peak 
and RMS level, and the elapsed and remaining time. 

Right-clicking in the control panel brings up options to display an expanded set of 
command buttons and test information. These commands are used to adjust the 
operation of the test such as changing the output level. These commands, along 
with all of the display fields, will be described in the following chapters on the 
specific test modes. 

 

Figure 71: Standard Spider Control Panel 
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Figure 72: Expanded Spider Control Panel 

There are three tabs on the bottom of the control panel for viewing different pages 
of information: Input, Output and Cursor. The Input tab sets the analysis 
parameters (block size, window type, overlap, and average) and trigger settings for 
the input channels. The Output tab controls the output function generator. The 
Cursor tab shows the abscissa and ordinate values for all displayed cursors and 
peak and harmonic markers. On the very bottom of the control panel the system 
connection status is displayed, along with any messages related to test events. 

Measured Signal Setup 

 

Figure 73: Signal Setup Window 

The Signal Setup page is under Setup->Measured Signals. This tab lists all of 
the signals available from the system hardware and denotes which of them are 
included in the test with an asserted Measurecheck mark. In addition, available 
time stream signals have a Record Listcheck box and block signals offer a Save List 
option. Measure enables the channel for display, Record List enables the channel 
for recording, and Save List enables the channel for block saving. Only time-stream 
signals can be recorded and only block signals can be saved. 

The signals are divided by type in the tabs on top. The Time Stream tab lists the 
native time stream signals. The other tabs list signals that are derived or computed 
from these native signals. These signals are organized in blocks rather than 
continuous streams. Deselecting Measure for these derived signals disables their 
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computation and saves processor resources. When recording is activated, by the 
menu command or the Rec. button on the control panel, all signals with the Record 
List option enabled will be recorded to a file. When the Save Sigs Button is pressed, 
all signals with the Save List option enabled will be saved to disk. 

In the Time Blocks tab, the block signals have the additional options of RMS, Peak, 
and Peak-Peak display. Enabling these will create a signal that is the time history of 
RMS, peak, or peak-peak value for every block (one point per block).The color used 
to display the signals can also be changed here. 

 

 

Figure 74. Signal Setup Time Block Tab 

In the PC Math Signals tab, EDM allows users to do math computation between a 
signal and another signal or a constant. The math rules are defined as shown in the 
table below. 
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Figure 75. PC Math Signals 

Operand 1 Operator Operand 
2 

Math Signal Unit How to calculate 

Signal1 Plus Signal2 (The same as signals, APS 
type. Only signals with the 
same EU can be calculated) 

[EURMS^2+EURMS^2] = 
EURMS^2 

Signal1 Minus Signal2 (The same as signals, APS 
type. Only signals with the 
same EU can be calculated) 

Abs(EURMS^2-EURMS^2) = 
EURMS^2 

Signal1 Multiply Signal2 (The same as signals, APS 
type. Only signals with the 
same EU can be calculated) 

[EURMS^2*EURMS^2] = 
(EURMS^2) 

Signal1 Divided 
by 

Signal2 (N/A. Treat as CPS if both 
signals are APS.) 

[EURMS^2*EURMS^2] = 
N/A 

Signal Plus Constant (The same as signals, APS 
type) 

[EURMS^2 + const^2] 

Signal Minus Constant (The same as signals, APS 
type) 

[EURMS^2 - const ^2] 

Signal Multiply Constant (The same as signals, APS 
type) 

Apply the constant to the 
original data (EURMS^2) 

Signal Divided 
by 

Constant (The same as signals, APS 
type) 

Apply the constant to the 
original data (EURMS^2) 

Constant Plus Signal (The same as signals, APS 
type) 

[EURMS^2 + const ^2] 

Constant Minus Signal (The same as signals, APS 
type) 

[const ^2-EURMS^2] 

Constant Multiply Signal (The same as signals, APS 
type) 

Apply the constant to the 
original data (EURMS^2) 

Constant Divided 
by 

Signal (The same as signals, APS 
type) 

Apply the constant to the 
original data (EURMS^2) 
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In the On-board FRF tab (only available when FRF box was checked at the time 
of creating the test), the Spider calculates the FRF signals and transmits it to 
the PC for display. Any one channel in the Spider system can be specified as the 
reference channel by clicking the Change Reference Channel button and 
selecting the proper channel. 

 

Figure 76. On-board FRF Signals 

 
In the PC FRF tab, FRF signals are calculated by the PC instead of the Spider. 
Since the PC FRF relies on the PC‘s resource which is much more powerful than 
the Spider‘s processor, hundreds of FRF signals can be computed 
simultaneously without consuming the Spider‘s resource. Multiple channels can 
be specified as reference channels. 
 
The relationship between input (force excitation) and output (vibration 
response) of a linear system is given by: 
 

 𝑌 =  𝐻  𝑋   
     

where {Y} and {X} are the vectors containing the response spectra and the 
excitation spectra, respectively, at the different DOFs in the model, and [H] is 
the matrix containing the FRFs between these DOFs. 
 
The equation above can also be written as: 
 

𝑌𝑖 =  𝐻𝑖𝑗 𝑋𝑗

𝑗
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whereYi is the output spectrum at DOF i, Xjis the input spectrum at DOF j, and 
Hijis the FRF between DOF j and DOF i. The output is the sum of the individual 
outputs caused by each of the inputs. 
 
The FRFs are estimated from the measured auto- and cross-spectra of and 
between inputs and outputs. Different calculation schemes (estimators) are 
available in order to optimize the estimate in the given measurement situation 
(presence of noise, frequency resolution, etc...). 
 
For the classical case of a single input, the equation above gives the output at 
anyDOF i, with the input at DOF j, as: 
 

𝑌𝑖 = 𝐻𝑖𝑗 𝑋𝑗  𝑜𝑟 𝐻𝑖𝑗 = 𝑌𝑖/𝑋𝑗  

 
since the input is zero at all the DOFs other than j. 
 

 
 

The FRF Hijcan be estimated using the various classical estimators such as: 
 

𝐻1 = 𝐺𝑋𝑌/𝐺𝑋𝑋  
or 

𝐻2 = 𝐺𝑌𝑌/𝐺𝑌𝑋  
 
where GXX and GYY are the auto spectra of input and output respectively, GXY 
is thecross-spectrum between input and output, and GYX is the cross-spectrum 
betweenoutput and input (i.e., the complex conjugate of GXY)1. H1 has the 
ability, by averaging,to eliminate the influence of uncorrelated noise at the 
output, whereas H2 has the ability,by averaging, to eliminate the influence of 
uncorrelated noise at the input. Comparedto H1, H2 is less vulnerable to bias 
errors at the resonance peaks caused by insufficientfrequency resolution (called 
resolution-bias errors). 

 

Test Configuration 

The Test Configuration window is used to set test-specific software options and 
parameters. It is divided into a number of sections accessed by the list on the left. 
Many of these sections are specific to particular test modes and are described in 
subsequent chapters. Other sections are for common functions shared by all test 
modes. These are also described in other sections of this manual. The Test 
Configuration window will be frequently referenced throughout this text. 
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To access these settings, go to Setup, select the Test Configuration item under 
the Setup menu or click the Config button on the control panel. 

 

Figure 77: Access to Test Configuration 

 

Running a Test 

When using accelerometers it is a good idea to do a quick check to verify if they are 
working correctly. Tap your finger close to where the accelerometers are mounted. 
The input should register a signal between 0.1 and 10 g‘s of acceleration. Anything 
significantly out of this range can indicate a problem with the connection or 
channel setup. The Input Channel Status also provides an overview of the current 
input levels. It can be activated from View->Channel Status. 

 

Figure 78: Input Channel Status 

Once ready, there are four ways to start a test: the F2 function key, the Run button 
on the control panel, the Run button on the toolbar, and the Run command in the 
Control menu. 
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To locate a specific test you can search for text in the Test Description edit box. The 
database manager can quickly locate tests with a keyword search. 

Viewing Signals 

Signal data is displayed under the Signal Display tabs. More than one of these tabs 
can be opened but only one is active at a time. Each tab can have a custom title. 
Each Signal Display tab contains one or more display windows. These windows 
display data in various kinds of plots. These windows can be freely arranged inside 
the tabs or ordered using the commands under the Layout menu. 
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Figure 79: Signal windows that can displays hundreds of signals 

There are many ways to open a new display window. A signal can be directly viewed 
by right-clicking on it and selecting Display in a New Window.  

 

Figure 80: Display a Signal in a New Window 

A blank window can be created from a window template by selecting the template 
under the View menu. 

 

Figure 81: View Tab 

When you select an item from the View menu, a dialog is displayed allowing you to 
select the type of window and the signals to display. The available signals are listed 
on the left, and the plot types are shown on the right. 
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Figure 82: Window Customizer 

 

You can also create a new, empty window by right-clicking next to the display 
window tabs, and selecting the type of window. 
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Figure 83: Create New Display Window by Right-clicking Top Bar 

There are many different types of windows here (only some of these may be 
available depending on the current test type).Right-clicking the top bar of any 
window opens the window customizer dialog shown above. The other types of 
windows are described here: 

Empty Window: is a single frame window. Multiple signals can be overlaid in this 
type of window. 

Stack Window: plots each signal in a separate plot, stacked vertically. All signals 
in a stacked plot must have the same x-axis quantities. 

Bode Plot: plots the magnitude and phase of a signal in a stacked plot. 

Waterfall Window: shows a 3D display with time on one axis, frequency on 
another, and amplitude in the third. 

ColorMap Window: plots frequency in the horizontal direction, time in the 
vertical direction, and uses color to represent magnitude. 

Numeric Window: displays numeric values of the signal in a table. 

Control Composite Window: displays the test profile, control profile, alarm and 
abort lines in an overlaid plot for vibration controller modes. 

Channel Status Window: displays the status with parameters for all channels. 
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Run Log Window: shows a log of test events as they occur. 

Digital IO Window: displays the current state of the digital inputs and outputs. 

 

RMS, Peak, Peak-Peak, and Mean values can be shown for signal attributes. 

 

Figure 84: Attributes of Signal Display 

Channel Status Window: shows the current state of each input channel. Both 
bar graphs, which show the current overall voltage level and numerical readings are 
shown.  

 

Figure 85: Channel Status Window 

The bar graphs are in a logarithmic scale so that the presence of both low-level and 
high-level signals can be seen. The readings show the minimum, maximum, RMS, 
and Peak levels for the units set in the channel setup table. If the input units are in 
acceleration, then the signal is integrated to show the velocity peak and double 
integrated to show the displacement peak. The integration is done digitally and 
should only be taken as estimation; the accuracy should not be relied on. 

The Overload column shows when a channel is overloaded due to an input signal 
exceeding the input maximum. Readings from an overloaded channel should not be 
used. 
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Channel status information can be updated by right-clicking in the window and 
selecting Start Refresh when a test is not running. 

Once a window is created with a type and combination of displayed signals, it can 
be saved as a custom window template. To save the current window layout, select 
the window and choose Save Active Window as User Defined under the Display 
menu. After saving, this template will be available under User Defined Windows in 
the Display menu. 

Signals can also be added to existing windows. Dragging a signal from the signal list 
to a window will display it in the window. You can also right-click on the signal and 
select Add to the Active Window. Note that the target window for the signal must be 
a valid option for the signal type. 

Contextual Menus 

Right-clicking in the various parts of the user interface in EDM will bring up a 
contextual menu where commands and options related to the area clicked are 
displayed. 

Right-clicking on a signal in the signal list brings up the following choices: 

 

Figure 86: Context of Signals 

Display in a New Window creates a new Display Window in the active View tab 
and adds the selected signal to it. 

Add to the Active Window adds the selected signal to the currently selected 
Display Window. Note that only signals of the same type can be added to the same 
window; i.e. a time signal cannot be added to a window that already contains 
frequency data. 

Apply Alarm Limits add limit lines to current signals. 
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Remove Alarm Limits from All Signals removes limit lines from all signals. 

Export Data to MS Excel exports the signal data to an Excel file. 

Export Data to Fileexports the signal data to a data file. 

Save Signal saves currently displayed signals to the run folder. 

Cache Signal savescurrently displayed signals to the clipboard for immediate use. 

Rename allows the display name of the signal to be changed. 

Add Annotation allows file objects to be referenced to the signal. 

Attach Object allows text annotations to be referenced to the signal. 

Remove All Annotation and Attachment wipes out all attached attributes. 

Report Signal Chart generates a report for the current signal chart. 

Right-clicking on the Signal Display tab titles brings up a contextual menu with 
commands to manipulate the tabs: 

 

Figure 87: Signal Display Attributes 

Add Signal Tab adds a new (empty) Signal Display tab. 

Close Signal Tab closes the current Signal Display tab. 

Close All But This keep the only current Signal Display tab open, and closes all 
others. 

Rename Signal Tab renames the tab. 

Print Signal Tab prints the signal tab. 

Dock all Windows docks all windows contained in the tab. 
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Undock All Windows turns all windows contained in the tab into floating 
windows. 

Layout Manage has options for auto-arranging the windows contained in the tab. 
These commands are duplicated in the Layout menu. 

You can rearrange the layout of the different windows by clicking on the title tab of 
any window and dragging it to a new location. While dragging, the Dock to Location 
icon will be displayed. Dragging the window onto one of the arrows docks it to the 
edge of that view. Dragging on to the center of the icon adds it as a tab behind the 
current window. 

The Plot Popup Menu can be accessed by right-clicking inside a window. This menu 
includes commands to change the contents and format of a plot. Many of these 
items can also be accessed on the toolbars. 

 

Figure 88: Plot Popup Menu 

View as Stacked Plot is available if there is more than one signal in the plot 
window. Stack mode will display each signal in separate plots, stacked vertically. If 
the window is already in Stack Mode, then Switch to Overlaid Mode will be 
displayed instead. Overlaid Mode will show each signal in the same plot. 

Zoom Back zooms out to the previous zoom ratio 

Un-Zoom All zooms out to the full scale so the entire signal is visible 
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X/Y Scale has options for adjusting the scale of the X and Y axes. 

 

Figure 89: X/Y Scale Options 

Auto Range turns on automatic scaling for the axes 

Restore Scalereverts to the previous axes display 

Axis Setting opens this window, used to set a custom range. This can also 
be opened directly by double-clicking on the axis label area. 

 

Figure 90: X-Axis Setting 

 Edit Axis Title allows users changing the title of the axis. 

Add Cursor/Marker adds a vertical or horizontal cursor or peak and valley 
markers to the active window 

Remove Cursor/Markerremoves cursors or markers from the window 

Remove Signal removes signals that are currently displayed from the active 
window 
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Remove All removes all displayed signals from the window 

Copy copies either signal data or a bitmap image of the window in its current state 
onto the clipboard. Copy Signal into Clipboard allows the current signal to be 
copied and then pasted into another Display Window using the Paste Signal(s) item 
below: 

 

Figure 91: Copy Signal Data or Bitmap 

Save Bitmap allows the bitmap image of the window to be saved to a file 

Paste Signal(s) pastes previously copied signals into the window 

Horizontal Axis changes between linear and logarithmic frequency axis format 
for frequency-based signals. 

Vertical Axis changes the vertical axis to decibel (dB) or linear magnitude (Mag) 
scaling. This is only available for frequency-based signals. 

Spectrum Type defines the units for spectrum signals as power spectral density 
(EU2/Hz), energy spectral density (EU2s/Hz), squared units (EUrms

2), peak units 
(EUpeak), or RMS (EUrms). Again, this only applies to frequency-based signals. 

Signal Color defines the color scheme used for the signal plot. 

Report this Windowgenerates a report from the window in MS Word format. 

RMS Display Setup defines how RMS values are displayed on the plots. RMS 
values can be displayed for the overall signal on each plot or only for a specified 
frequency band. 
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Figure 92: RMS Display Setup 

Customize Notation Setting allows the user to edit numerical value notation 
and floating point formatting. 

Plot Properties opens the Plot Properties section of the EDM Global Settings. 

NOTE: The background color of the plot can be edited from the Plot Properties-
>Plot tab as shown below. The background color is only applied to plots displayed 
on the screen; it will not be applied to plots in generated reports; these will have a 
white background. Please note that if plot lines are also white then the plots 
generated in reports will appear blank (white on white). 
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Figure 93: Background Color Setting 

  

Frequency and Frequency Response Windows 
Windows that display data in the frequency domain have additional options to 
change how a spectrum is displayed. These options can be found in the contextual 
menu in Frequency plot windows. 
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Figure 94: Frequency Window Options 

Horizontal Axis changes between linear and logarithmic scaling of the frequency 
axis. There is a default option that defines the attributes of new windows. To change 
the default settings, set the desired attributes and select Set as Default. 

 

Figure 95: Horizontal Axis 

Vertical Axis changes the unit type and scaling of the vertical (ordinate) axis. For 
frequency plots of signals that only have magnitude values (such as auto power 
spectra).The options are dB units, linear magnitude, or logarithmic magnitude 
scaling. 
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Figure 96: Vertical Axis 

Some frequency plots, such as linear FFT, cross power spectra, and frequency 
response functions have complex ordinate values. Complex values have both real 
and imaginary parts, which can be converted to magnitude and phase. For these 
plots, there are additional options for displaying real values, imaginary values, or 
phase (in degrees). 

Display Window Toolbar 

When a window is in focus, the Quick Access Toolbar will appear. All of the 
commands shown in the Quick Access Toolbar can also be accessed through the 
contextual menu. The toolbar makes common commands accessible with one click. 
Hovering the mouse over a button will show the button‘s function. Some of these 
functions have been described above. 

 

Figure 97: Display Window Toolbar 
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Zoom Back: zoom out to the previous zoom state 

Auto Scale: automatically scale the X and Y axes 

The Cursor and Marker icons control the display of cursors and 
markers on the current plot. See the next section. 

When a window is displaying a block signal, the right side of the toolbar shows the 
current and total frame count. 

 

When a time stream signal is being displayed, the Global View button is added on 
the right side. This view lets you control the time scale by clicking and dragging the 
arrows on the left and right sides of the gray bar that highlights the portion of the 
waveform that will be displayed in the main pane. This feature allows you to 
efficiently view long waveforms. The Global View can be hidden or revealed by 
clicking on the up or down arrow in the upper right corner of the view. 

 

Figure 98: Global View for Time Waveforms. 

Annotations: these buttons create a section, cursor, and text 
annotation on the current display. See the Annotations section below. 

Absolute/Relative time: this toggles the displayed time values between 
relative time, where zero is the beginning of the time stream, and absolute time. 
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Time Stream Display Duration: for live time-stream signals, 
this changes the total time duration that is visible. 

Annotations 

Annotations are text notes that are attached to a display window. These notes can 
store signal attributes, cursor values, or user-entered text. 

A section annotation displays signal values between two displayed cursors: 

 

A cursor annotation displays the X and Y values of one cursor: 

 

A user text annotation allows the user to enter any text. 

 

Annotations are also listed in the signal list. 
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Cursors and Markers 

Cursors allow features of a waveform to be measured such as a peak value or the 
time between two events. Cursors are added by pressing the button on the toolbar 
or by pressing the space bar on the keyboard. 

When any vertical cursor is enabled, pressing the up arrow will search for peak 
values in the vicinity of the cursor(s), and those values will be displayed. 

 

Move a cursor by clicking and dragging it with the mouse. The arrow keys move all 
cursors together. 

When a cursor is added to a window, the X and Y values are shown in the Cursor 
view on the right side of the screen. 

Marker annotations can be displayed with signals. Right-click on a signal to add a 
marker. 

 

Mouse over the signal tab to show the function buttons. Select the Hide/Show 
Marker Annotation to manipulate the marker annotation. 
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Figure 99:Pane with Two Vertical Cursors 

Markers display the peak or valley features of a waveform. Add markers by right-
clicking in the display and selecting Add Cursor/Marker. Marker data is also 
displayed in the Cursor tab on the Control Panel.
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Figure 100: Add Cursors and Markers 

Saving and Recording Data 

As previously described, there are two methods of data retention during a test: 
Saving and Recording. A save is activated by pressing the Save button on the 
control panel, which saves block signal data and figures of display windows to the 
local disk.Press the Rec. button to activate recording, which records time stream 
data to the internal flash memory. 

Although EDM supports up to 24 Spider modules with 192 input channels, 
recording to flash memory has certain limitation when highest sampling rate of 
102.4 kHz is selected. At the sampling rate of 102.4 kHz, the recording to flash 
memory is limited up to 144 channels (6 channels * 24 modules). At sampling rate 
of 81.92 kHz or lower, the recording to flash memory can apply to 192 channels at 
maximum. 

To activate saving or recording in a schedule or when some events happen, Save 
results to PC, Save signals to internal memory, Start recording, and Stop recording 
are actions that may be inserted. Please refer to the Event-Action rules section for 
more detail.  

Under the Measured Signals Setup, time stream signals have a Record List option 
and other signals have a Save List option. These options control whether the signals 
are included in a saving or recording operation. 

When recording or saving to the internal flash memory, the data files that are 
created are not visible in EDM until they are downloaded. To download files, select 
Download from Spider Internal Flash in the Tools menu. 
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Figure 101: Spider File Download 

In the window that appears, all data files will be shown with associated test names. 
Multiple files may be downloaded at the same time to the folder specified on the 
bottom right corner.  

Save/Recording Setup 

There are several options for the Save and Recording functions in the Test 
Configuration window. 
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Figure 102: Save/Record Setup 

The options are provided to determine when the software should save results to PC 
and which display windows are saved with signals. 

Save results to PC under the following conditions 

Common options for all test types:  

Software saves the results 

 when test schedule just starts 

 when test aborts 

 when test pauses 

 Enable a timer when schedule starts: save with the timer enabled 
after a run starts 

Options only available in FFT and Acoustic analysis: 

Software saves the results 
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 when test just finished 

 when average number is reached 

 save 3D signals when test aborts 

 every  ___seconds 

 FrameNumber: the results of the given number of frames 

 when limit is exceeded 

 when triggered 

 Enable a timer when continue after trigger: save with the timer 
enabledafter a run is triggered to start 

Options only available in Sine reduction: 

Software saves the results 

 when sweeping direction changes 

When the software saves results to PC, results include 

 Signals 

 Screenshot of the active signal window 

 Screenshots of all signal windows 

 Screenshots of the software 

In the File name options area, Record and Save file name prefixes may be 
defined separately and differentiated. 

Record to Spider-NAS 

Spider-NAS (Network Attached Storage) is a dedicated storage device that works 
with front-end modules from Crystal Instruments, including the Spider-80x, 
Spider-81, and Spider-DAQ.  The Spider-NAS is connected to each Spider data 
acquisition module through eight high-speed data bus ports, and an Ethernet port 
is used to configure and control the system from any location on the network. 

For the hardware including hardware settings, details are introduced in the Spider-
NAS Manual. 

Although EDM supports up to 24 Spider modules with 192 input channels, 
recording to NAS has certain limitation when highest sampling rate of 102.4 kHz is 
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selected. At the sampling rate of 102.4 kHz, the recording to NAS is limited up to 
168 channels (7 channels * 24 modules). At sampling rate of 81.92 kHz or lower, the 
recording to NAS can apply to 192 channels at maximum. 

In EDM, Record to Spider-NAS function can be found under Global Settings-
>Working Folder as shown below. Once the Record to Spider-NAS is selected, all 
the recorded data files will be saved to Spider-NAS system by default. 

 

Open a Recording Status window to show the progress of recording: 
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Using Libraries 

 

Figure 103: Library Tab 

A number of settings, including the Channel Table, Reference Profile, Run Schedule, 
Event Action Rules and Shaker Parameters allow the use of libraries. When linked 
to a library, the settings are saved to the library and are updated if any changes are 
made to them from within another test. For example, if the same shaker is used in 
multiple tests then a library can be created for its parameters. If one of these 
settings is changed, the change will be reflected in all the tests that are linked to this 
library.  

To create a new library file based on the current settings, click Save to Library 
and enter a name and an optional description. When a name is assigned, it is set to 
public, which allows it to be referred to by other tests. 

To make a library the default selection in all new tests, click Save As Default. In 
all future tests, the library name will show up in the Library Reference drop-down 
menu. Selecting the library name in the list will link the current test to the library 
and replace the current settings with those of the library. To delete the library, press 
the red X next to the name.  
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Figure 104. Set the Library Element as "Private" 
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Figure 105: Set the Library Element as "Public" 

Using libraries can save setup time. For example, in a testing lab, the sensitivity 
values will be changed every time the sensors are calibrated. If no library is used the 
user will have to manually change the sensitivity values in all the tests. If a library is 
used, the user simply updates the library and the values can be applied to all tests. 

Event-Action Rules 

There are many events that can occur during the course of operation for a test, 
including certain response levels being reached, limits being exceeded, and user 
caused events such as pause or stop. The Event-Action Rules feature offers the most 
flexibility in controlling the system operation by customizing the response to these 
events. 

Event-Actions Rules define the response of the controller to these test events. Many 
actions are available as custom responses, such as sending an e-mail or stopping the 
test. When an event occurs, the corresponding action rule(s) will be automatically 
applied by the software. 

In the Event Action Rules user interface of EDM, the left column, Event Name, lists 
events while the right column, Action Rules, lists the corresponding actions taken 
by the software. System events are in blue words and user events are in green words. 
User events can be manually added, renamed, and removed. Click ―Add a User 
Event‖ button to add a new user event to the event list. Click to highlight a user 
event and click ―Edit Event Name‖ to rename the user event. Click to highlight a 
user event and click ―Remove Event‖ to delete the user event from the list. 
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Figure 106. Event Action Rules 

 

System Events 

System events (shown in blue words) are predefined in the software. They events 
can occur during a typical test. The list of all available system events in Spider DSA 
mode follows. 

Limit Exceeded – a signal exceeds a limit value placed on the channel. There are 
two types of limits, high and low. Before using this event, the Limit must be 
configured under Apply Alarm Limits option by right-clicking the signal in the Live 
Signal tab. 

Average Number Reached –when Linear Average mode is in use, the event 
occurs when the average reaches its full programmed count. The Average number 
must be set before running the test and the averaging mode must be linear. 

Output Reaches Maximum – an output channel reaches its full-scale voltage. 

Channel Overload – any channel exceeds its full-scale voltage. 

User Pressed Stop – the ―Stop‖ button (either a software or a hardware button) 
is pressed.  
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Just Triggered – a trigger condition is met during the test. The trigger condition 
can be configured by clicking the Setup Trigger button in the control panel. 

Connection Lost – the hardware is no longer detected by the software. 

Download Complete – the data downloading is completed. 

Actions List 

One or more actions (up to 5) can be added to the corresponding action rules of 
each event. When an event occurs, the corresponding actions will be triggered. The 
system will automatically execute the actions in the list. 

All available actions are listed below.  

 

Figure 107. Available Action 

 

Flash Screen and Beep – the EDM User Interface shows a light green flash on 
the status window. EDM will also send a beeping sound to the PC sound card. 

Create Report – a report is created with the template defined under the report 
tab. 

Capture Screen – a screenshot is taken to the clipboard. The users can paste it to 
any application or save it to a file. 

Send Email – a predefined email is sent by EDM. 
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The email server can be configured under Tools->Global Settings->Mail Setting. 

Send Socket Messages– a socket message is sent to another application. The 
users must configure the socket server and client using Tools->Global Settings-
>Socket Server. 

 

Send Digital Output Signals – a digital pulse or level is sent via Digital the I/O 
port. Only one pin (of pins #05~#08) can be selected at a time. There are four 
output signal patterns are available (Low-High-Low, High-Low-High). The Low 
voltage is 0 V, and the High voltage is 3.3 V. When the output pattern is either 
Lowe-High-Low or High-Low-High, the user is allowed to set the pulse duration by 
entering the numeric value of millisecond. 
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Start Recording –EDM starts recording the time stream signals. The channels to 
be recorded are defined under Setup->Measured Signals->Time Stream.  

Stop Recording –EDM stops recording the time stream signals. Usually this 
action follows a Start Recording action after certain duration of recording. 

Save Signals to PC –EDM will save the signals to a file and store it on a PC‘s hard 
drive. Signals to be saved are defined under Setup->Measured Signals. 

Save Signals to Internal Memory –EDM sends a command to the front-end 
module to save signals to its internal memory. The signals to be saved are defined 
under Setup->Measured Signals. 

Reset Average –EDM resets the average. 

Stop the Test –EDM stops the test. 

Limit Check Off –EDM disables limit checking. 

Limit Check On –EDM enables limit checking. 

 

User Defined Events 

Aside from the events generated by the control system, the user can define his/her 
own events and insert them into a run schedule. These events then can then trigger 
user-defined actions. Click Add a User Event to insert a new user defined event. All 
available actions can be attached to this event.  
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Event Action Rules Setup 

 

Figure 108: Event Action Rule Setup 
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The Event-Action Rules tab in the Test Configuration window defines the actions 
that will occur in response to test events. User-defined events can also be 
customized. The list box on top lists all the events and their actions. System events 
are blue and user defined events are green. When an event is selected, its associated 
actions are listed below. Use the buttons on the top of the lower list to add or 
remove actions, to rename user events and to save changes. 

Reports 

EDM can generate customizable reports in Microsoft Word format that summarize 
the test setup and results (Microsoft Word 2003 or later is required for this feature). 
Reports are generated from templates, which define the formatting and what data is 
to be included. 

To define a new template: select (Define Template) in the Report menu. 

 

Figure 109: Report Options 

All defined templates are listed under the Templates drop-down menu in the left 
column. The rest of the window shows the settings for the selected template. 

The Report Items column shows all of the various items that can be included in the 
template. Un-checking the box next to an item will exclude that section from the 
report. The Active Window item will include the currently selected display window 
at the top of the report. You can also create a report that only has the active window 
and none of the other sections. 

The right side of the window has 3 tabs, Logo, Page and Report Title for 
controlling the format of the report. A customized logo can be uploaded to EDM 
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and added to the report. Page orientation and size can be defined as can report title 
and font size, color and format. 

Once a template has been created, you can generate a report by selecting the 
template name from the Report menu. 

 

Figure 110: Report Template 

You can also generate a report that only includes one plot. To do this, configure a 
display window in EDM as needed.Then, confirm that the plot is selected, right-
click in the plot area, and select Report This Window. Annotations and cursors 
will be included in the report. You can also select New Report ->Active Window 
from the Report menu. This will use the Default Template to control the 
formatting of the report. 
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 Figure 111: Report a Window from the Display 

 

 Figure 112: Report a Window from the Report Tab 
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Figure 113: A Sample of My Report 

 

Similarly, you can create a report that includes only the plots in the current view tab 
by selecting New Report ->Active View. Selecting Test Report will create a 
report with all the items enabled in the Default Template (the same as selecting 
Default Template in the Report menu). 

 

Black Box Mode 

The Spider platform from Crystal Instruments operates as a real-time data 
acquisition and analysis system while connected to a desktop PC. It can also 
function as a stand-alone data recording system that does not require a separate 
computer. This second mode is called Black Box Mode and it is unique to Crystal 
Instruments‘ products. A computer is used to set up test parameters and to 
download test data after the test has been run. While running, the Spider operates 
autonomously according to a pre-set run schedule. Only single module systems can 
run in black box mode. 

The options to run the Spider module in Black Box Mode are: 
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1. Use a PC to re-connect to the Spider module. 

2. Use an iPad running the Crystal Instruments EDM App. 

3. Use the front-panel buttons of the hardware 

4. The EDM iPad App allows multiple Spiders to be remotely controlled by one 
iPad. 

5. All Crystal Instruments Spider platforms support Black Box mode. 

 

Running in Black Box mode eliminates the reliability issues caused by PCs in real-
time control and data acquisition applications. 

Black Box mode is ideal for production tests or long-duration tests. It is ideal for 
data acquisition applications that run without people in attendance. 
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Hardware devices connected to the local area network can be identified by their IP 
addresses when attempting to connect to them with PCs or iPads.  

 A separate manual, Spider Black Box Mode Manual, describes Black Box mode in 
detail; only a summary will be presented here. 

Each time a test is run from a connected computer, all of the test configuration data 
is uploaded to the internal memory of the front-end hardware. In normal 
operations, the computer remains connected allowing you to control the test and 
view the signals. However, all signal processing is performed by the front end 
module and not by the computer. Recorded data is stored on the internal memory 
of the front end. Black Box mode takes advantage of the fact that the computer is 
not actually needed for the test. 

To run in Black Box mode, first set up a test, in any mode, on the computer. The test 
will run according to the items in the Run Schedule. Select the signals to be 
recorded under the Measured Signals Setup tab. 

 

Figure 114: Measured Signal Setup Tab 

Under Event Action Rules in the Test Configuration window, create two user events: 
Start Recording Event and Stop Recording Event. 
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Figure 115: Event Action Rule 

Set up the run schedule. Use a loop to have actions repeated a set number of times. 
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Figure 116: Run Schedule 

Insert the Start and Stop Recording events. 

 

Figure 117: Insert Entries to the Schedule 

Then, connect to the Spider and run the test from the PC once. It is now loaded into 
the internal memory of the front end module. 
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Select Black Box Setup from the Setup menu and press Refresh.The test will be 
listed under Uploaded Tests. 

 

Figure 118: Black Box Setup Dialog box 

When the check box ―Always overwrite first entry when running a test‖ is checked, 
the active running test will always be automatically uploaded to the front-end as 
one of the tests that can be run in the Black Box mode.(If this option is not checked, 
the Black Box table will not be updated.) 

By default, the test in position 1 will run. This can be changed from the front panel 
LCD display. 

Tests stored in the front-end box can be executed by several means: an iPad 
connected to the box through wireless, via the digital I/O, or via the front LCD 
panel.  
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Run the Test with Front Panel 

To select which test to run, press the right arrow key on the Spider‘s front panel 
until the Test List is shown. Then use the up and down arrow keys to select a test. 
When the Start button is pressed, the selected test will be run. 

To start the test in Black Box mode, disconnect from the Spider and exit EDM. 
Press the Start button on the front panel of the Spider. Test status info will be 
shown on the front LCD panel and the MEM LED will illuminate when signals are 
being recorded. 

Press the Stop button to stop the test. 

To download the recorded files, reconnect to the Spider using EDM, and choose 
―Download Data Files‖ from the Tools menu. Select the recorded files in the list and 
click on ―Download Selected‖. 

 

Figure 119: Spider File Download 

The files will be downloaded to the current run folder. Click on the ―Data Files‖ tab 
on the lower left part of EDM to view the signals. 

Using Socket Messages to Communicate with Other Applications 

Socket messages are a convenient way for EDM to communicate with other 
Windows applications on the LAN. These Windows applications can be 
programmed in VB, VC, C#, LabVIEW, etc. 
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Figure 120: Socket Communication Diagram 

The use of socket messages by EDM is described in detail in a separate document 
titled: ―Socket Message Manual‖. 

Database Backup and Restore 

EDM can back up the current database to local files or import backup files to the 
current database, including test configuration data. Users can use Backup and 
Restore to migrate the database and manage data. 

Click Tools; select Backup and Restore Database to enter the main page. 

 

Figure 121: Backup and Restore Database 

On the ―Database Manage‖ page there are two tabs: ―Operation on Database‖ and 
―Batch Operation‖. Under the ―Operation on Database‖ tab, the database is set up 
to back up, restore, or delete. The backup rules may also be defined here. Check 
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―Auto Backup‖ to automatically back up the database. Database backup is for tests 
and data while the test backup is only for the tests (without data). Data file backups 
can be specified for a specific date range. 

 

Figure 122: Database Management - Operation on Database 

Under the ―Batch Operations‖ page, the database can be handled in batch. 

 

Figure 123: Database Management - Batch Operations 

Backup files can be in one of the following formats: 

.sdbk is a MySQL database backup file, including one or multiple databases and all 
data 

.sbk is a MySQL database backup file, including only one database and all data 
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.ssdbk is a SQL server database backup file, including one or multiple databases 
and all data 

.ssbk is a SQL server database backup file, including only one database and all data 

.sbk and .ssbk files are generated from the following dialog box with the backup 
command. 

.sbk files CAN be imported to SQL server databases. 

.ssbk files CANNOT be imported to MySQL databases. 

.sdbk is a MySQL database backup file, including one or multiple databases and all 
data 

.sbk is a MySQL database backup file, including only one database and all data 

.ssdbk is a SQL server database backup file, including one or multiple databases 
and all data. 

.ssbk is a SQL server database backup file, including only one database and all data 

.sbk and .ssbk files are generated from the following dialog box with the backup 
command. 

.sbk files CAN be imported to SQL server databases. 

.ssbk files CANNOT be imported to MySQL databases. 

 

Accessing an SQL Server Remotely 

The server and the client ends must be configured properly in order to access the 
SQL server remotely on the network. Follow these steps to configure the server: 

Go to Computer Management->Service and Applications->SQL Server 
Configuration Manager->SQL Server Network Configuration. 
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Figure 124: Computer Management 

 

Double-click any Protocols to view properties. Select TCP/IP and right click to 
select Properties. 

 

Figure 125: TCP/IP Properties 

―Enabled‖ must set to ―Yes‖ and the TCP Port must set to 1433. 
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On the left menu panel, select SQL Server Services, view SQL Server instances and 
SQL Server Browser. Both of them should be in the running state; if not, right-click 
the instance to start them. 

 

Figure 126: Computer Management - SQL Server Services 

At this point the server configuration is finished. The following steps describe how 
to configure the client end: 

Start the EDM software and go to Database Access Wizard from Tools->Access 
Database. Enter the server‘s IP address and the name of the instance in the format 
of IP Address/Instance Name as shown below. 
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Figure 127: Database Access Wizard 

If an error occurs, try to use Server Authentication. Certain Windows security 
restrictions may prevent the use of Windows Authentication at this step. 

 

Figure 128: Database Access Wizard 

The password for Username ―sa‖ can be reset via Microsoft SQL Server 
Management Studio on the server PC. 
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Figure 129: Reset SQL Server Password  
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Real-Time FFT Analysis 

FFT analysis is conducted in the DSA real-time operation mode. These applications 
involve Digital Signal Processing calculations such as the Auto-Power Spectrum, 
Cross Power Spectrum, and Fourier Transform etc. for input channel signals. 

Dynamic Signal Analyzer Basics 

This section will give an overview of the theory behind the functions performed in 
the FFT analysis mode of the Spider module.  For more detailed information on this 
topic please refer to ―Dynamic Signal Analyzer Basics‖ published by Crystal 
Instruments. 

The Fourier Transform is one of the most fundamental and popular methods of 
signal analysis. It transforms an infinite time waveform into its frequency 
components. These frequencies may then be analyzed or further manipulated to 
calculate phase or transfer functions. Because the Fourier Transform involves an 
infinite sum the signal must be broken into finite blocks of N samples. Each block is 
then transformed using the Discrete Fourier Transform (DFT) However, computing 
DFT is computationally intensive and so a more efficient algorithm called Fast 
Fourier Transform (FFT) was developed.  

Some applications of the FFT are listed below: 

Power Spectrum 

The magnitude of the frequency components of signals are collectively called the 
amplitude spectrum. In many applications, the quantity of interest is the power or 
the rate of energy transfer that is proportional to the squared magnitude of the 
frequency components. The average squared magnitudes of all of the DFT 
frequency lines are collectively referred to as the Power Spectrum, Gxx. The 
averaging process is more properly termed an ensemble average, wherein the 
squared amplitude from N signal blocks at a each measured frequency, f, are 
averaged together.  Letting an asterisk (*) denote conjugation of a complex number, 
the ―power‖ averaging process is defined by: 

𝑮𝒙𝒙 𝒇 =  𝑿 𝒇  𝟐 =
𝟏

𝑵
 𝑿𝒌 𝒇 𝑿𝒌

∗  𝒇 

𝑵

𝒌=𝟏

 

Cross Spectrum 

The Cross Spectrum characterizes the relationship between two spectra. For two 
signals 𝑥 and 𝑦, with frequency components X(f)and Y(f)it is defined as: 

𝑮𝒙𝒚 𝒇 =
𝟏

𝑵
 𝒀𝒌 𝒇 𝑿𝒌

∗  𝒇 

𝑵

𝒌=𝟏
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The Cross Spectrum reflect the correlation between the two signals. While the 
Power Spectrum is real-valued, the Cross Spectrum is complex. This means that it 
also describes the phase relationship between the two signals. 

Frequency Response Function 

An important application of Dynamic Signal Analysis is characterizing the input-
output behavior of physical systems. In linear systems, the output can be predicted 
from a known input if the Frequency Response Function (FRF) of the system is 
known. The Frequency Response Function, H(f), relates the Fourier Transform of 
the input X(f) to the Fourier Transform of the output Y(f) by the simple equation: 

𝒀 𝒇 = 𝑯𝒙𝒚 𝒇 𝑿 𝒇  

 
Multiplying both sides of this equation by the conjugate of the input spectrum and 
ensemble averaging explains the importance of the power and cross power spectra 
as they allow H(f) to be measured and calculated. 

𝟏

𝑵
 𝒀𝒌 𝒇 𝑿𝒌
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𝑵
 𝑿𝒌 𝒇 𝑿𝒌

∗  𝒇 

𝑵

𝒌=𝟏

= 𝑯𝒙𝒚 𝒇 𝑮𝒙𝒙 𝒇  

 

That is: 

𝑯𝒙𝒚 𝒇 =
𝑮𝒙𝒚 𝒇 

𝑮𝒙𝒙 𝒇 
 

The fact that Y(f) is dependent on the input X(f) is what makes the system linear. 
When measuring the input-output behavior of a system, there is always noise 
present that obscures the output. An important measure is how much of the output 
is actually caused by the input and a linear process. This is indicated by another 
important real-valued spectrum called the (ordinary) Coherence Function. This 
coherence function is also defined in terms of the cross spectrum and the power 
spectra. Specifically: 

𝜸𝒙𝒚
𝟐  𝒇 =  

𝑮𝒙𝒚 𝒇 𝑮𝒙𝒚
∗  𝒇 

𝑮𝒙𝒙 𝒇 𝑮𝒚𝒚 𝒇 
 

Note that the coherence can also be stated as the product of an FRF with its inverse 
function. That is, if Hxymeasures a process going from input, x, to output, y, Hyx 
characterizes the same process, but treats y as the input and x as the output.   

𝜸𝒙𝒚
𝟐  𝒇 = 𝑯𝒙𝒚 𝒇 

𝑮𝒙𝒚
∗

𝑮𝒚𝒚
=𝑯𝒙𝒚 𝒇 𝑯𝒚𝒙 𝒇  



 

131 Crystal Instruments Spider-20/20E Manual 

This product definition indicates the coherence represents an ―energy round trip‖ 
or a reflection through the process. We apply Gxx to Hxy and get Gxy at the output. 
Then we conjugate Gxy (to flip it or reflect x(t) in time) and pass it through Hyx.  In a 
perfect world, this would result in exactly Gxx as the output of Hyx.   

If the system is linear and none of our measurements are contaminated by noise, 
the trip is perfect and we get back everything we put in. That is, the coherence will 
be exactly 1.0. If the system is non-linear or if extraneous noise has been interjected, 
the round-trip will be less efficient and the coherence will be less than one (but 
never more). 

Thus, the coherence is always between 0 and 1. A coherence of 1.0 means the output 
is perfectly explained by the input (i.e. the system is linear). A coherence of 0 means 
the output and input are unrelated. Values in-between state the fraction of 
measured output power explained by the measured input power and a linear 
process. Experienced analysts always use the coherence measurement to quantify 
the quality of an FRF measurement at every frequency. 

Shock Response Spectrum 

The Shock Response Spectrum (SRS) is an entirely different type of spectral 
measurement. It is used access the damage potential of a transient event such as a 
package drop or an earthquake. The SRS was first proposed by Dr. Maurice Biot in 
1932. The SRS is not the spectrum of the pulse. (The FFT provides this.) The SRS is 
not a linear operator as the FFT is. That is, an SRS does not uniquely define a single 
waveform. Many very different transient time-histories can produce the same SRS. 

What the Shock Response Spectrum is, is the representative response of a class of 
simple structures to the given transient acceleration time-history. This response is 
provided by simulating a group of spring-mass-damper systems sitting on a 
common rigid base that is forced to move with the measured acceleration of the 
subject shock pulse. Each single degree-of-freedom (SDOF) spring-mass-damper 
has a different natural frequency; they all have the same damping factor. The 
spectrum is formed by plotting the extreme motion (acceleration) experienced by 
each mass against its resonance frequency. 

The frequency spacing of the resonance frequencies is logarithmic, much like the 
1/3 octave filters used in acoustical analysis. That is, it is a type of proportional 
bandwidth analysis where the half-power bandwidth of each SDOF system 
increases in proportion to its resonance frequency. The resolution of an SRS is 
defined by the number of simulated SDOFs included in the desired analysis span. 
The percent damping of all the SDOFs is selectable (although most tests specify 5% 
damping).  

The extreme motion of each mathematically simulated SDOF mass is monitored by 
several peak detectors. The extreme positive and negative accelerations are retained 
during the duration of the input pulse and after it. Maximum and minimum values 
captured during the pulse‘s duration are termed Primary extremes. Those found 
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after the pulse has returned to zero are termed Residual extremes. Specific tests will 
prescribe whether positive, negative or extreme absolute values captured should be 
displayed. They will further specify Primary, Residual or combined (maxi-max) 
data be plotted.  

Test Parameters 

The Test Configuration window, Analysis Parameters tab is used to configure tests. 

 

Figure 130. Analysis Parameters Tab of Test Configuration Window 

Overlap Ratio sets the proportion of the samples in a time block that are 
overlapped (redundant with samples in a prior block) when calculating the FFT of 
(un-triggered) continuous signals. Higher overlap ratios result in faster variance 
reduction per unit time producing smoother data but they increase the processing 
requirements. The Overlap Ratio options are: no overlap, 25%, 50%, 75%, 87.5%, 
95% and As High As Possible. For most applications employing a symmetrically 
tapered window function (such as Hanning), an overlap of 50% proves optimal. 

Block Size/ Lines are the number of samples in each time blocks and the number 
of (un-aliased) spectral lines in each resulting spectrum.  Increasing the block size 
increases the resolution of the frequency transform and allows lower frequencies to 
be detected but it also increases the calculation time and slows down response. The 
ratio between Lines and Block Size is determined by the characteristics of A/D 
converter and its anti-aliasing filter. In general, this ratio is about 0.46, meaning 
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that 1024 samples in the waveform will produce about 0.46 * 1024 = 471 lines in the 
spectrum. 

Sampling Rate(together with block size) determines the resolution and the span 
of all time and frequency data blocks. Increasing the sample rate increases time 
resolution (makes dT smaller), and decreases the time span (Block T) captured. 
Increasing the sample rate also increases the maximum frequency (Fa) in a spectral 
block and decreases its resolution (increases dF). 

Average Number is the number of blocks that are ensemble averaged for the 
signal spectrum. Increasing the number of averages will reduce the variance of the 
signal spectrum. 

Average Mode options include: Linear, Exponential, and Peak Hold. Linear 
averaging treats every block equally. The blocks are simply added together (at each 
frequency) and the result divided by the Average Number. Exponential averaging is 
a moving or evolving average that favors the most recently measured block. Old 
data slowly loses its importance (time exponentially), so that the average is 
dominated by the current instantaneous spectrum.  

Window Type lets the user choose the window to be applied during FFT 
operation. Windowing functions can help reduce leakage and increase the precision 
of the frequency measurement. In general select None for triggered transients, 
Hanning for general continuous signals and Flat Top when studying tonal data 
(such as a rotating machine) and needing extreme accuracy of spectral peaks. 
Detailed descriptions about window types and average modes can be found in the 
DSA Basics document.  

Reference Channel allows the user to choose a channel as a referencefor the 
calculation of the Frequency Response Function, Coherence, and Cross Power 
spectrum. The user can specify the selected channel to be either the excitation 
(input) channel or the response (response) channel when creating the test. Signals 
such as CPS, Coherence and FRF are defined based on this selection. 

Run Schedule 
 

The Run Schedule allows a test to be run automatically through a preset routine. 
The run schedules for FFT analysis tests are only effective in Black Box Mode. 
Schedules can include loops and time periods for running the test at specified levels 
and durations. The run schedule can also activate any user-defined events defined 
in the Event Action Rules. Click on event names in the list on the left to insert them 
into the schedule and use the buttons on top to edit or remove them or change their 
order. The schedule is activated when the test is started in Black Box mode. 
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Figure 131. Run Schedule Tab 

 

Measured Signals in FFT 

The ―Live Signals‖ tab on the lower left of the screen in EDM shows all the 
measured signals available for display. Listed here, for all test modes, are the time 
streams of the input channels labeled by their location ID (―PT1‖, ―PT2‖, ―PT3‖… by 
default), and the output drive time stream. The location ID of the channels can be 
changed under the Channel Table tab. Time stream signals are labels as Ch1[t]. 
The numerical value depends on the channel index. 
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Figure 132. Live Signal 

 

There are also signals derived from these time streams: block signals, labeled Block, 
FFT of time signals, labeled as FFT, auto power spectra signals, labeled APS, and 
the frequency response functions, labeled FRF. The labels are followed by the 
location ID of the original time stream signal in parenthesis (or, in the case of FRF, 
the location ID of the excitation channel followed by the ID of the response 
channel). These signals will only show in the live signal list if the measure option is 
enabled in the Signal Setup tab. 
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Figure 133 Frequency response functions measured in a high channel 
count system 

Time block signals are labels as Block(Ch1)[t]. The numerical value depends on 
the channel index. For the convenience of signal calculation and transformation, 
the time stream is chopped into the individual blocks by block size. Each block 
contains the defined number of data points sampled from the time stream signals. 

APS (Auto-Power Spectrum) signals are labeled as APS(Ch1)[f]. The numerical 
value depends on the channel index. 

 

Output Setup 

The FFT test has an additional tab for output channel setup. Here you can configure 
one or more output channels as shaker drive or other DUT stimulation signals. 
Since closed loop control is not available, the user should be careful to stay within 
the safety limits of the shaker/amplifier and test object when configuring the output 
levels. All enabled channels will send out drive signals while the test is running. The 
following window can be found from Setup->Output Channels. 
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Figure 134. Output Channels for FFT 

The Output Channels for FFT Analysis dialog lists all available output channels 
in the system. Each available output is identified by Module and Output Chanel 
(connector) number. 

On/Off provides a check box to enable (turn On) or disable (turn Off) each 
available output. 

Output Type provides the choice or Random, Sine and Swept Sine signals. 

Info provides a summary of each channels setup. 

Select a signal source in the first column and press the Set Up button to bring up a 
dialog to set the specific amplitude, frequency span, phasing and sweep type/rate 
settings desired for each signal.   

 

Control Panel 

The expanded Control Panel in FFT analysis mode has a number of commands to 
control the operation of the test. Right-clicking in the Parameters tab can expand 
the Control Panel. 
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Figure 135. Expanded Control Panel 

Test state information is displayed in the following fields: 

Total Elapsed is the time elapsed since the test was started. 

Output Pk is the peak voltage of the output drive signal.  

Frame# is the number of frames (frequency blocks) elapsed since the test was 
started.  

The control panel has input and output settings under two separate tabs. 

Under the Input tab, all the test analysis parameters are provided to allow users to 
make changes during live running mode. Changes made to these parameters during 
the test will take effect immediately.  

Some extra buttons are provided for additional tasks: 
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Reset Averageclears the average and resets the current average number back to 
zero. This nullifies the effects of an unwanted event. 

Turn Output On/Off enables / disables the output channel of the Spider device. 
The output settings can be configured under output tab of the control panel. 

View Window opens up the window configured for the test. 

Setup Trigger gives the option of setting up a trigger-based action with the help of 
event action rules. Only the input channels on the master module can be set as the 
trigger source. 

Trigger Switch turns the trigger On/Off. 

Output Switch turns the output On/Off. 

Limit Check Switch enables/disables the limit check. 

 

Figure 136. Advance Trigger Setup 
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Figure 137. Simple Trigger Setup 

Using the controls shown in above screenshot, you can setup a trigger threshold for 
the selected input signal. Any signal meeting the threshold condition will activate 
the trigger and cause a signal block to be captured.  The Delay Time or Delay Points 
settings allow the data to be captured starting before or after the trigger point. The 
trigger action that occurs can be selected using appropriate Mode settings box. 
Event action rules can be specified for events named ―Just triggered‖.  

Trigger Switch is used to enable/disable the trigger. The system will wait for the 
trigger to capture signal data. 

The user can preview the Trigger window to view the instant the system is 
triggered.  
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Acoustic Analysis 

The Acoustics Data Acquisition option includes Fractional Octave Filter Analysis, 
Sound Level Meters and Microphone Calibration functions. 

The Fractional Octave Filter Analysis function applies a bank of real-time 
1/nthoctave filters to the input time streams and generates two types of responses at 
the same time: 1/Nth octave spectra, and the RMS time history of each 1/Nth octave 
filter band. The output of each real-time filter bank is in fact a 3D waterfall signal 
that is arranged with the x-axis as logarithmic frequency and the z-axis as time. 
Frequency weighting is applied in the frequency axis and time-weighting is applied 
in the time axis.  

The Sound Level Meter (SLM) (also referred to as Overall Level Meter) also uses 
octave filters during acoustic data acquisition. The SLM applies ONE frequency 
weighting filter to the input signal and time weighting to the output. Various 
measures are then extracted from both the input and output signals of this 
frequency weighting filter. 

Octave Filters 

Acoustics Analysis provides 1/Nth octave analysis using true real-time digital filters 
in accordance with ANSI std. S1.11:2004, Order 3 Type 1-D and IEC 61260-1995 
specifications. A, B and C weighting filters can be applied to the input data. Output 
results are weighted or un-weighted RMS values. The output can be normalized 
with a calibration value. The results can be plotted on log or linear axes and exact or 
preferred frequency values are supported.  

Each band filter is designed in accordance with ANSI S1.11 and IEC 61260 
specifications. The original analog signal is transferred to the digital domain by 
means of the bilinear transform. The filter order can be specified and the frequency 
ratio can be calculated using the binary or decimal system.  

The RMS reading of each octave filter is usually represented by a ―bar‖ in the 
spectrum plot. Keep in mind that the octave filters are actually somewhat wider 
than the bars depict. Just like the analog filters they emulate, digital filters have 
tapered pass-bands or ―skirts‖; they are imperfect frequency selectors.. The filter 
bands are not as sharp as the bars depict them, hence adjacent filters always 
overlap one another. For this reason, a sine tone at 1 kHz will not only excite the 
filter with center frequency at 1 kHz, but also all of the other filters as well, albeit to 
much lower levels.  

 



 

142 Crystal Instruments Spider-20/20E Manual 

 

Figure 138. Sample of Octave Test 

Full Octave Filters 

An octave is a doubling of frequency.   For example, frequencies of 250 Hz and 500 
Hz are one octave apart, as are frequencies of 1 kHz and 2 kHz. 

 

Figure 139. Full octave filter shape. 

 

Full octave analysis, i.e., 1/1 octave, displays the frequency characteristics of a signal 
by passing the signal through a bank of band-pass filters with passbands and octave 
wide and the center frequency of each filter an octave apart from its neighbors. If 
the lower and upper cutoff frequencies of a band-pass filter are 𝑓𝐿and𝑓𝐻 , then the 
center frequency,𝑓𝑐  can be determined with:  

𝑓𝑐 =    𝑓𝐿 ∗  𝑓𝐻  

The nominal frequency ratio G is determined by: 
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𝐺 = 𝑓𝐻/𝑓𝐿  

Two descriptive systems are commonly used to describe proportional bandwidth 
filters: Base-two (fractional octave) or Base-ten (fractional decade). A full octave 
filter has a G of 2, numerically equal to 103/10. Hence this same filter is termed a 
3/10 decade filter. Crystal Instruments CoCo analyzers describe proportional filters 
by their decade resolution. 

Proportional bandwidth analysis divides frequency information uniformly over a 
log scale which is very useful for analyzing a variety of natural systems such as the 
human response to noise and vibration. Many mechanical systems also display 
behavior that is best characterized by proportional bandwidth analysis. 

Fractional Octave Filters 

To gain finer frequency resolution, the frequency range can be divided into 
proportional bandwidths that are a fraction of an octave. For example, with 1/3 
octave analysis, there are 3 band-pass filters per octave where each center 
frequency is 2 1/3 (101/10)the previous center frequency. 

In general, for 1/Nth octave analysis, there are N band pass filters per octave such 
that:  

𝑓𝐻
𝑓𝐿

=  2 1/𝑁 

𝑓𝑐𝑗 +1 = 𝑓𝑐𝑗 ∗   2 1/𝑁 

where 1/N is called the fractional bandwidth resolution. 

 1/1-Octave 1/3-Octave 1/6-Octave 1/12-Octave 

Standard  

IEC 225-1966 
DIN 45651 
ANSI S1.11-
2004 Order 7 
Type 1-D 

IEC 225-1966 
DIN 45651 
ANSI S1.11-
2004 
Order 3 Type 
1-D 

N/A N/A 

 

band 
number 

-3 ~ 14 -10 ~ 43 -20 ~ 86 -40 ~ 172 

Total 
number 
of Filters 

18 54 107 213 

𝑓𝑐  (Hz) 0.125  – 16k 0.1 – 20k 0.1 – 20k 0.1 – 20k 

Table 2. Octave Center Frequencies. 
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Nominal center frequencies (mid-band frequencies) 

Nominal center frequencies are ―round‖ numbers that were historically established 
for analog octave filters. The nominal mid-band frequencies for 1/1-octave and 1/3-
octave are listed in the ANSI S1.11-2004 Annex A. This standard also describes how 
to determine the nominal mid-band frequencies for other fractional octave bands. 

The exact center frequency of the filter band is usually not equal to the nominal 
frequency. For example, in a 1/3 octave, the exact center frequencies 794.33 Hz, 
1000 Hz and 1258.9 Hz are used to correspond to the filters with nominal 
frequencies 800 Hz, 1000 Hz and 1250 Hz. 

Band Edge Frequencies of Fractional Filters 

The low and high frequency band edges of a filter can be calculated based on the 
frequency ratio, G and the fractional octave resolution N (=1, 3, 6, 12…) 

𝐿𝑜𝑤𝑒𝑟𝐸𝑑𝑔𝑒𝐹𝑟𝑒𝑞𝑢𝑒𝑛𝑐𝑦𝑓𝐿 = 𝑓𝑐 ∗   2 −1/2𝑁 

𝑈𝑝𝑝𝑒𝑟𝐸𝑑𝑔𝑒𝐹𝑟𝑒𝑞𝑢𝑒𝑛𝑐𝑦𝑓𝐻 = 𝑓𝑐 ∗   2 1/2𝑁 

The bandwidth of the filter is: BW = 𝑓𝐻 − 𝑓𝐿 

When starting or resetting the filtering operation of the fractional-octave filters, a 
certain time is required before the measurements are valid. This time is called the 
settling time and is related to the bandwidth of any particular filter. The lowest 
frequency band has the smallest bandwidth and thus defines the settling time 
required before you can consider the complete fractional-octave measurement valid. 
A good rule of thumb is that the prudent settling time estimate is five resolution 
reciprocal time periods, that is: 

𝑆𝑒𝑡𝑡𝑙𝑖𝑛𝑔𝑡𝑖𝑚𝑒 =
5

𝐵𝑊
=

5

𝑓𝐻 − 𝑓𝐿
 

Note the settling time depends on the bandwidth which changes with center 
frequency. A narrower filter and a lower frequency band requires a longer settling 
time. 

Analysis Frequency Range 

You can decide the analysis range by changing the lowest and/or highest 𝑓𝑐   as the 
Analysis Parameters: 
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Analysis 
Range 

1/1  
Octave 

1/3 
Octave 

1/6 
Octave 

1/12 
Octave 

Lowest 𝒇𝒄 
(Hz) 

0.125 
1 
8 

0.1 
1 

10 
100 

0.1 
1 

10 
100 

0.1 
1 

10 
100 

Highest 𝒇𝒄 
(Hz) 

1000 
4000 
16000 

1000 
2000 
5000 

10000 
20000 

1000 
2000 
5000 

10000 
20000 

1000 
2000 
5000 

10000 
20000 

 

Frequency Weighting 

Human hearing is more sensitive to some frequencies than to others, and its 
frequency response varies with level. In general, low frequency and high frequency 
sounds appear to be less loud than mid-frequency sounds, and the effect is more 
pronounced at low pressure levels, with a flattening of response at high levels. 
Octave analysis and sound level meters therefore incorporate weighting filters, 
which reduce the contribution of low and high frequencies to produce a 
measurement that more nearly approximates how we hear. 

 

Figure 140. Frequency weighting filter shapes. 

The Spider provides A, C, and Z weightings conforming to IEC 61672-1 2002 and B 
weighting conforming to IEC 60651 in both of Octave analysis and Sound Level 
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Meter. The Frequency weighting in the octave filters affects the results of all filter 
bands.  

Time or RPM based RMS Trace of the Octave Filters 

The ANSI and IEC standard do not require storing the time history of the band pass 
filter output. However the user may be interested in viewing this information. Using 
a Spider, the RMS histories of all the band pass filters are stored in the RMS 
quantity. Below is the description of how the RMS history is calculated.  

The RMS history can be stored against one of two variables: Time or RPM. 

Both the input and output of a digital filter are a series of data points. While it 
requires excessive memory to keep all of the time data from all of the filters, it is 
useful to keep the running RMS history of each filter‘s output. The RMS time 
histories are computed after the time weighting averaging operation as shown 
below. 

Frequency
Weighting Octave filter

RMS 
estimate & 

Time 
weighting

Decimator
r.m.s. 
bufferRaw 

data
Trace Update 

Time

Octave filter

Octave filter

 

Figure 141. RMS time history calculation. 

The Decimator allows the user to choose the length of time for the RMS data. For 
example, given a buffer length of 1024, a Trace Update Time of 5 ms will keep about 
5 seconds of RMS history; if this update time is set to 5 seconds, it will record 5000 
seconds (1.4 hours) of RMS history. 

If a cut is made across the Z axis, the resulting XY plane will be an octave spectrum. 
If a cut is made across the X-axis (frequency), the result will be called a Time Trace.  

The Time Trace stores the history of the RMS of each filter output. The spacing 
between two points in the Time Trace is called Trace Update Time, in seconds. On 
the Spider, one Time Trace is allocated for each channel for display. Keep in mind 
that this buffer of Time Trace is the output of a specific filter, the user can change 
the center frequency of the filter for the Time Trace during run time. In other words, 
this time trace display buffer will change its content completely if the user switches 
the Time Trace Frequency. 
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Alternatively the RMS trace can be stored using RPM as a variable. This method is 
particularly useful in the automotive NVH applications.  The picture below shows 
how one of the filter outputs can be stored in RPM trace. 

Frequency
Weighting Octave filter

RMS 
estimate & 

Time 
weighting

Delta RPM
Low RPM
High RPM 

RMS 
bufferRaw 

data

Octave filter

Octave filter

 

Figure 142. Store RPM based RMS traces. 

Exponential and Linear Averaging 

Linear averaging: Linear averaging uses a fixed time period to sum up the 
historical power value of each filter and then takes the square-root to calculate the 
averaged RMS value. The RMS trace update time is governed by the time period of 
the averaging. For each time period of averaging, one RMS value per frequency bin 
is produced. 

Exponential averaging: Exponential averaging applies an exponential time 
constant to the historical power values of each filter and takes the square-root of the 
averaged power value. A time constant of 0.125 seconds is equivalent to ―Fast‖ 
averaging and 1.0 second is equivalent to ―Slow‖ averaging of a sound level meter. 
In exponential averaging, the RMS trace update time is independent of the time 
constant.  

Peak Hold averaging: Peak Hold retains the maximum value in each frequency 
bin over the period of time since last ―start‖ or ―restart‖. It is a one-time extreme 
observation over the interval rather than an averaged property. 

As discussed previously, each filter may have a different settling time of 
approximately 5/BW seconds.  
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Figure 143 Octave Spectra and FFT APS Processed at same time 

Sound Level Meter 

A sound level meter measures sound pressure level. A standard sound level meter is 
more correctly called an exponentially averaging sound level meter because the AC 
signal from the microphone is converted to an RMS level,  requiring a duration of 
integration termed the ―time constant‖. Three of these time-constants have been 
standardized, 'S' (1s) originally called Slow, 'F' (125 ms) originally called Fast and 'I' 
(35 ms) originally called Impulse.  

The output of the RMS detector circuit is a linear voltage proportional to pressure. 
This is passed through a logarithmic converter to give a readout in decibels (dB). 
The pressure dB is 20 times the base 10 logarithm of the ratio of a given root-mean-
square sound pressure to the reference sound pressure. (The standard reference 
sound pressure in air or other gases is 20 µPa, which is usually considered to be 
the threshold of human hearing at 1 kHz).Root-mean-square (RMS) sound 
pressure is calculated using standard time and frequency weightings. 

With the advent of digital technology and the increasing accuracy of electronic 
circuits, sound level meter functions are now frequently calculated in the digital 
domain. High dynamic range is one of the most important measures of the quality 
of an acoustic analyzer as it assures that both weak and strong signals can be 
calculated and observed. The Spider provides 130dB dynamic range, which is 
exceptional for this application.   

Traditional sound level meters only include 1/1 and 1/3 octave filters. The CoCo 
systems ability to do octave analysis and other advanced analysis functions provides 
more flexibility and computation power than a traditional sound level meter.   

Use Octave Analysis as the template to create a CSA project when fractional octave 
analysis is required.  In both the Octave Analysis and Sound Level Meter templates 
the user can see the frequency weighted readings (such as dBA) but the reading 

http://en.wikipedia.org/wiki/Micropascal
http://en.wikipedia.org/wiki/Threshold_of_human_hearing
http://en.wikipedia.org/wiki/Hertz
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results may be slightly different when comparing Octave Analysis and Sound Level 
Meter results because the data is processed and the values are computed differently. 
In octave analysis, the A-weighted sound level (dBA) is computed by applying the 
frequency weighting function to the output of each individual filter bank; while in 
SLM, the A-weighted sound level is calculated by applying the A-weighting filter to 
the entire time domain. The SLM template should be used to obtain the dBA or 
similar overall readings for sound studies that would be comparable to those 
measured with a traditional sound level meter.  

Terms and Definitions 

In this section we will define the terminology used in the SLM software options. 

Reference sound pressureis conventionally chosen as 20 μPa.  This is the 
threshold of hearing (at 1 kHz) for the average person and is used to compute the 
sound pressure level in the dB scale. 

Sound pressure level (in dB) is defined as twenty times the logarithm to the 
base ten of the ratio of the RMS of a given sound pressure to the reference sound 
pressure. Sound pressure level is expressed in decibels (dB); symbol Lp. 

Peak sound pressure is the greatest absolute instantaneous sound pressure 
during a stated time interval. 

Peak sound level (in dB) is defined as twenty times the logarithm to the base 
ten of the ratio of a peak sound pressure to the reference sound pressure the peak 
sound pressure being obtained with a standard frequency weighting. (Example 
letter symbols are Lpeak, Lcpeak) 

Frequency weighting is the difference between the level (dB) of the signal 
indicated on the display device and the corresponding level of a constant-amplitude 
steady-state sinusoidal input signal, specified in the IEC or ISO standards as a 
function of frequency.  It accounts for the A, B and Z frequency weightings 
discussed in the previous section. 

Time weighting is an exponential function of time, of a specified time constant, 
that weights the square of the instantaneous sound pressure. This is the same as 
exponential averaging in the time domain of the instantaneous sound pressure. 

It is a continuous averaging process that applies to the output of a frequency 
weighting filter or one of the fractional octave filters. The amount of weight given to 
past data as compared to current data depends on the exponential time constant. In 
exponential averaging, the averaging process continues indefinitely.  

In a sound level meter the time weighting exponential averaging mode supports the 
following time constants:  
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 Slow uses a time constant of 1,000 ms.  Slow averaging is useful for 
tracking the sound pressure levels of signals with sound pressure 
levels that vary slowly.  

 Fast uses a time constant of 125 ms. Fast averaging is useful for 
tracking the sound pressure of signals with sound pressure levels that 
vary quickly.  

 Impulse uses a time constant of 35 ms if the signal is rising and 
1,500 ms if the signal is falling. Impulse averaging is useful for 
tracking and recording sudden increases in the sound pressure level. 

 User Defined allows you to specify a time constant suitable for your 
particular application. 

Time-weighted sound level (in dB) is twenty times the logarithm to the base 
ten of the ratio of a given RMS sound pressure to the reference sound pressure, 
RMS sound pressure is obtained with standard time and frequency weighting. 
(Example letter symbols are L

AF
, L

AS
, L

CF
, L

CS
) 

Maximum and minimum time-weighted sound level (in dB) is the 
greatest and lowest time-weighted sound level within a stated time interval. 
(Example letter symbols are L

AFmax
, L

ASmax
, L

CFmax
, L

CSmax
, L

AFmin
, L

ASmin
, L

CFmin
, L

CSmin
) 

Time-average sound level (equivalent continuous sound level) (in dB) is 
twenty times the logarithm to the base ten of the ratio of a RMS sound pressure 
during a stated time interval to the reference sound pressure, sound pressure being 
obtained with a standard frequency weighting. (Example letter symbols are L

Aeq
, L

Ceq
) 

Sound exposure is the time integral of the square of sound pressure over a stated 
time interval or event. Sound exposure is used to measure high-level, short duration 
noises and to study their effects on humans.  

Sound exposure level (in dB) is the total sound energy of a single sound event 
that takes into accounts both its intensity and duration. Sound exposure level is the 
sound level you would experience if all of the sound energy of a sound event 
occurred in one second. Normalization to duration of one second allows for the 
direct comparison of sounds of different durations. 

 

Figure 144. Sound exposure level illustration. 
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Figure 144shows the relationship between the Sound Exposure Level (SEL), the 
Sound Pressure Level (SPL), and the Leq. The Leq is the constant level needed to 
produce the same amount of energy as the actual varying sound (the SPL).  

The SEL is the Leq normalized to 1 second. It is what the Leq would be if the event 
occurred over a one second duration. 

Statistical Level (LN)is defined as the sound pressure level which is exceeded N% 
of the time over the duration of a measuring time interval. L0 is the maximum level 
over the duration of the measurement. L100 is the minimum.  

Data Processing Diagram 

Figure 145 shows the data processing diagram for ONE input channel for all the 
SLM measurements when A-weighting is applied. 

 

Figure 145. Sound level meter computation diagram. 

In the SLM measurement, after the digitized data comes in, it is split into three 
paths: one goes to frequency weighting A, B, C or Z and one goes to C weighting or 
no weighting. The peak detection is computed from the output of C weighting or no 
weighting. The output of frequency weighting (A, B, C or Z) is further split into two 
paths. The first will go to a time weighting function which is more or less equivalent 
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to an exponential averaging mode to calculate LAF; the second path goes to a time 
averaging function, which is equivalent to a linear averaging mode to calculate Leq. 

With A-weighting applied as shown in the example, the list of symbols used by the 
instrument is: 

Symbol of 
Measured 
Values Description 

LAF A-weighted, F time-weighted sound level 

LAFmax Maximum A-weighted, F time-weighted sound level 

LAFmin Minimum A-weighted, F time-weighted sound level 

LCpeak 
Peak C sound level, greatest absolute instantaneous 
C-weighted sound pressure level 

Lpeak 
Peak sound level, greatest absolute instantaneous  
sound pressure level 

LAeq 
A-weighted, time-average sound level (equivalent 
continuous sound level) 

LAeqmax 
Maximum A-weighted, time-average sound level 
(equivalent continuous sound level) 

LAeqmin 
Minimum A-weighted, time-average sound level 
(equivalent continuous sound level) 

LAE A-weighted sound exposure level 

LN (N = any 
integer 
between 
0~100) 

Statistical Level general term 

L1, L5, L50, 
L95.... 

Statistical Levels with specific N values. The sound 
level exceeds this level 1, 5, 50 or 95 percent of the 
time for the duration of the measurement. 

 

SLM Measures 

There are two ways to view sound level measurements: instantaneous SLM 
measurement and RMS history. Instantaneous SLM measurements represent the 
most current value of the subject variable.  

RMS history not only shows the most current value, but also a record of historical 
values against time or RPM. Some of the measures allow only instantaneous values 
others allow both.    

The following SLM measurement are available for real-time reading and can be 
saved as a data structure for future review. 

Time Weighted Sound Levels 

Time weighted sound level is the output of frequency-weighting and then time 
weighting filters. Time weighting serves an exponential averaging operator. The 
computation is illustrated in Figure 146.  
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Frequency 
Weighting 

Filter

RMS 
estimate & 

Time 
weighting

RPM or 
Time 
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bufferRaw 

data

Time-based 
buffer

 

Figure 146. Time weighting sound level computation and storage against RPM or 
Time 

The table below shows the symbols for the time-weighted sound level. 

Symbol used for time 
weighted value 

Frequency Weighting 

Z A B C 

Time  
Weighting 

F(Fast) LZF LAF LBF LCF 

S(Slow) LZS LAS LBS LCS 

I(Impulse) LZI LAI LBI LCI 

Custom LZC LAC LBC LCC 

 

 

Figure 147 Typical Measurement Values of SLM 

 
 

Time Averaged Sound Levels 

The Time averaged sound level is the output of frequency-weighting and then time 
average operation. Time averaging uses a linear averaging operator. Figure 
148illustrates the computation. 
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Figure 148. Time averaged sound level computation. 

The table below shows the symbols for the time-average sound level. In the time 
averaging sound level measurement, frequency weighting can be selected as A, B, C 
or Z. The time interval for time averaging can be set to any value between 1 second 
and 24 hours. 

Frequency 
Weighting 

Z A B C 

Symbol L
eq 

L
Aeq 

L
Beq 

L
Ceq 

 

Peak sound level 

Only C-weighted and un-weighted signals are available for peak sound level as is 
required by the standards. 

Symbol Lpeak LCpeak 

 

Sound exposure level 

Sound exposure level and time-average sound level have the same frequency 
weighting and same time interval. 

Frequency Weighting Z A B C 

Symbol L
E 

L
AE 

L
BE 

L
CE 

 

Statistical level: value reading 

Any statistical level L
N
 is the sound level which is exceeded for N% of the defined 

measurement duration. 

Symbols for LN,  
N = 1, 5, 50, 95 

L1 L5 L50 L95 

 

Input Channel Time Streams 

In the Spider, time domain data is always available in the form of a long time 
history. The user can view and record the time signals but the sampling rate of the 
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time signals cannot be arbitrarily changed. It is always set internally by the system 
based on the analysis frequency range. 

RMS trace of weighted level, time averaged level or sound exposure 

The Spider records an RMS trace of the sound level.  The user must choose between 
the time weighted level, LAF, the equivalent time averaged level, LAEQ, or sound 
exposure level, LAE. Only one can be recorded at a time. 

Histogram of Time Weighting 

The Spider also records a signal containing a histogram of the dB values of the time 
weighted signal. This signal is used to compute the Ln data. 

 

 

Creating Acoustic Tests 

EDM runs in the context of a loaded test project. A test project consists of an input 
and output configuration, analysis parameters, and acquired data. A new test is 
created by selecting New Test in the Test menu. This opens the New Test Wizard. 
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Figure 149: Create a New Acoustic Test 

Click the Acoustic Analysis tab on the left to start creating an acoustic analysis test. 

 

Figure 150: The Wizard for a New Random Test 
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The next page allows you to name the test and write a description. For the acoustic 
analysis test, there is a third page in the wizard where different analysis 
computations can be enabled or disabled, such as Auto Power Spectra (APS), 
Tachometer (TACHO), Octave Analysis (OCT), and Sound Level Meter (SLM).  

 

Figure 151. Signal Types in Acoustic Analysis 

 

Figure 152: An Acoustic Test 
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This screen is divided into 5 parts. On the top is the menu and toolbar section. On 
the left side, there are two sections: the Recent Test List and the Signal List. On the 
right is the Test Control and status window. In the middle are the Signal Display 
and Signal Setup tabs. 

Recent Test List 

 

Figure 153: Recent Tests List 

On the upper left part of the screen, the Recent Tests list shows current and 
previous tests. Each test is listed by its name and type (VCS or DSA). Each test entry 
is expandable to display items underneath related to the test. 

System lists the hardware modules associated with this test. The system is 
set up with the Spider Config window, described under System 
Configuration. The name of the system is displayed in parentheses. 

Signal List 

The Signal List shows live signals and saved data available for display. 
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Figure 154: Signal List 

Live Signals include all input channels that are a part of the current system and the 
output channels. Depending on the test type, there may be other signals such as the 
control profile, associated alarm, and abort lines. The list is divided in categories for 
time streams, block signals, and frequency data from these sources. It can also be 
viewed according to the hardware modules by right-clicking on the list and selecting 
Sort Signals by Spider Modules. 

Run Folders tab displays the recent Runs: 
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After the user presses the Run button and the test finishes, a ―run‖ is generated. By 
default, a Run folder is created on the disk. As shown in the picture above, for a 
given test, Random1, a test file, Random1.stk, is created, and each Run in the Run 
Folder tab, corresponds to a physical folder on the disk.  

Data Files are time streams and block data saved or recorded to disk. All of the data 
files under a specific Run will be saved into that Run folder. When block signals are 
saved by clicking the Save Sigs button, a data file will be created and displayed 
here. 

 

Figure 155: Data Files Tab 

 

Control Panel 

The Control Panel is used to control the test and display status information in real-
time. The connection status of the hardware is shown on top, with a button to 
Connect/Disconnect (if no hardware is detected, this button will not be displayed). 
The control buttons — Run, Pause, Stop,Save Sigs — duplicate the items in the 
Control menu and on the Control toolbar. Config opens the Test Configuration 
window. Rec./Stop starts/stops the recording after test runs. 

Below the control buttons, information on the state of the test is displayed. 
Depending on the test mode, this includes the output level (as a percent) and peak 
voltage, the control input peak and RMS level, the target peak and RMS level, and 
the elapsed and remaining time. 
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Right-clicking in the control panel brings up options to display an expanded set of 
command buttons and test information. These commands are used to adjust the 
operation of the test such as changing the output level. These commands, along 
with all of the display fields, will be described in the following chapters on the 
specific test modes. 

 

Figure 156: Standard Spider Control Panel 

 

Figure 157: Expanded Spider Control Panel 

There are tabs on the bottom of the control panel for viewing different pages of 
information. The Cursor tab shows the abscissa and ordinate values for all 
displayed cursors and markers (peak and harmonic). 

There are Input, Output, and Cursor tabs. The Input tab sets the analysis 
parameters (block size, window type, overlap, and average) and trigger settings for 
the input channels. The Output tab controls the output function generator. 

On the very bottom of the control panel the system connection status is shown, 
along with any messages related to test events. 
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Measured Signal Setup 

 

Figure 158: Signal Setup Window 

The Signal Setup page is under Setup->Measured Signals. This tab lists all 
signals with a Measure option. In addition, time stream signals have a Record List 
option and block signals have a Save List option. Measure enables the channel for 
display, Record List enables the channel for recording, and Save List enables the 
channel for block saving. Only time-stream signals can be recorded and only block 
signals can be saved. 

The signals are divided by type in the tabs on top. The Time Stream tab lists the 
native time stream signals. The other tabs list signals that are derived or computed 
from these native signals. These derived signals are organized in blocks rather than 
continuous streams. Deselecting Measure for these derived signals disables their 
computation and saves processor resources. When recording is activated, by the 
menu command or the Rec. button on the control panel, all signals with the Record 
List option enabled will be recorded to file. When the Save Sigs Button is pressed, 
all signals with the Save List option enabled will be saved to disk. 

The trace color used to display the signals can also be specified here. 

Test Configuration 

The Test Configuration window is used to set test-specific software options and 
parameters. It is divided into a number of sections accessed by the list on the left. 
Many of these sections are specific to a particular test mode, and are described in 
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the subsequent chapters regarding these modes. Other sections are for common 
functions shared by all test modes, and are described in their own sections of this 
manual. This window will be referenced many times throughout this text. 

To access these settings, go to Setup, select the Test Configuration item under 
the Setup menu, or click the Config button on the control panel. 

 

Figure 159: Access to Test Configuration 

 

Running a Test 

If microphones are used, a good check is to clap your hands near each microphone 
and observe that a signal has been heard. The Input Channel Status also provides 
an overview of the current input levels. It can be activated from View->Channel 
Status. 

 

Figure 160: Input Channel Status 
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Once ready, there are four ways to start a test: the F2 function key, the Run button 
on the control panel, the Run button on the toolbar, and the Run command in the 
Control menu. 

 

 

Viewing Signals 

Signal data is displayed under the Signal Display tabs. More than one of these tabs 
can be opened but only one is active at a time. Each tab can have a custom title. 
Each Signal Display tab contains one or more display windows that display data in 
various kinds of plots. These windows can be freely arranged inside the tabs or 
ordered using the commands under the Layout menu. 

 

Figure 161: Signal Display Window 

There are many ways to open a new display window. A signal can be directly viewed 
by right-clicking on it and selecting Display in a New Overlaid Window.  
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Figure 162: Display a Signal in a New Window   

A blank window can be created from a window template by selecting the template 
under the View menu. 

 

Figure 163: View Tab 

When you select an item from the View menu, a dialog is displayed allowing you to 
select the type of window and which signals to display. The available signals are 
listed on the left, and the plot types are shown on the right. 
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Figure 164: Window Customizer 

 

You can also create a new (empty) window by right-clicking next to the display 
window tabs, and selecting the type of window. 
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Figure 165: Create New Display Window by Right-clicking Top Bar 

There are 11 different types of windows here but depending on the current test type, 
only some of them may be available. Right-clicking the top bar of any window 
opens the window customizer dialog shown above. The other types of windows are 
described here: 

Empty Window: is a single frame window. Multiple signals can be overlaid in this 
type of window. 

Stack Window: plots each signal in a separate plot, stacked vertically. All signals 
in a stacked plot must have the same x-axis quantities. 

Numeric Window: displays the numeric values of the signal in a table. 

Bode Plot: plots the magnitude and phase of a signal in a stacked plot. 

Waterfall Window: shows a 3D display with time on one axis, frequency on 
another, and amplitude in the third. 

ColorMap Window: plots frequency in the horizontal direction, time in the 
vertical direction, and uses color to represent magnitude. 

Recording Status shows if each channel is on recording or on idle along with the 
recording parameters. 

Channel Status Window: shows the current state of each input channel. Both 
bar graphs which show the current overall voltage level and numerical readings are 
shown. 

 

Figure 166: Channel Status Window 
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Run Log Window: shows a log of test events as they occur. 

System Graph Window: displays the topology of networked Spider units and 
their system information such as hardware type, IP address, SN, and running status. 

Digital IO Window: displays the current state of the digital inputs and outputs. 

Save Window as User Defined: saves current window with user defined name 
and this saved window can be recalled from View tab. 

Rename This Window: changes the name of the current window. 

Close This Window: closes the current window. 

Close Other Windows: closes all other windows except the current window. 

RMS, Peak, Peak-Peak, and Mean values can be shown for signal attributes. 

 

Figure 167: Attributes of Signal Display 

The bar graphs are in a logarithmic scale so that the presence of both low-level and 
high-level signals can be seen. The readings show the minimum, maximum, RMS, 
and Peak levels, in the units set in the channel setup table. If the units are in 
acceleration, then the signal is integrated to show the velocity peak and double 
integrated to show the displacement peak. The integration is done digitally and 
should only be taken as estimation; the accuracy should not be relied on. 

The Overload column shows when a channel is overloaded due to an input signal 
over the input maximum. When in the overloaded state, the readings from the 
channel should not be used. 

The channel status information can be updated while a test is not running by right-
clicking in the window and selecting Start Refresh. 

Once a window is created, with a type and combination of displayed signals, it can 
be saved as a custom window template. To save a current window layout, select the 
window and choose Save Active Window as User Defined under the Display menu. 
After saving, this template will be available under User Defined Windows in the 
Display menu. 

Signals can also be added to existing windows. Dragging a signal from the signal list 
to a window will display it in the window. You can also right-click on the signal and 
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select Add to the Active Window. Note that the target window for the signal must be 
a valid option for the signal type. 

Test Parameters 

The Test configuration window, analysis parameters tab is designed to configure 
test settings as required.  

 

Figure 168. Test Parameters for Acoustic Analysis 

FFT Analysis Parameters 

Block Size/ Linesdefines the size of the time blocks in terms of the number of 
samples, which the FFT algorithm transforms to a number of spectral Lines in the 
frequency domain. Increasing the block size increases the resolution of the 
frequency transform and allows lower frequencies to be detected but this also 
increases the calculation time and slows down response.  

The ratio between Lines and Block Size is determined by the characteristics of A/D 
converter and anti-aliasing filter. In general, the ratio is about 0.46 which means 
that a time block of 1024 samples results in about 0.46 * 1024 = 471 Lines in the 
spectrum. 
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Window lets the user choose the window to be applied during FFT operation. 
Windowing functions can help reduce leakage and increase the precision of the 
frequency measurement. Detailed descriptions about window types and average 
modes can be found in the DSA Basics document. 

Overlap Ratio sets the proportion of the samples in the time blocks that are 
overlapped when calculating the FFT. Higher overlap ratios result in faster 
response time but increase processing requirements. The Overlap ratio options are:  
no overlap, 25%, 50%, 75%, 87.5%, 95%, and As High as Possible. 

Average Mode gives options such as: Exponential, linear and peak hold as the 
methods used to average the signal spectrum.  

Average Number is the number of blocks that are averaged for the signal 
spectrum. Increasing the number of averages reduces the variance of the signal 
spectrum. 

FFT Average On/Off enables / disables the FFT average function. 

Reference Channel Settings allows the user to choose a channel as a 
referencefor calculating the frequency response function, coherence and cross 
power spectrum. The user can specify the selected channel to be either the response 
channel or the excitation channel. Signals like CPS, Coherence and FRF are defined 
based on this selection. 

Octave Filter Parameters 

Octave Resolution defines the octave resolution including: 1/1, 1/3, 1/6 and 1/12. 

Low Frequency Bound (Hz) defines the low frequency (span) of the 
measurement in Hz. 

High Frequency Bound (Hz) defines the high frequency (span) of the 
measurement in Hz. 

Average Type defines the averaging type including: exponential, linear and peak 
hold.  

Frequency Weighting defines the frequency weighting including: A, B, C or Z. 

Time Trace Frequency (Hz) defines which center band frequency, overall or 
frequency weighted band is used to plot time traces. 

Trace Update Time(s) defines the time trace display duration.  Select a larger 
update time to create longer time trace display duration. 

Sound Level Meter Parameters 

Time Trace Type defines the time weighting includes L, Leq and LE. 
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Analysis Period specifies the time duration for each analysis period. 

Result Update Time(s) defines how many times the result will beupdated. 

Result History defines the measurement length of the result history. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Order Tracking 

Introduction 

Order Tracking is a general term describing a collection of measurement functions 
used for analyzing the dynamic behavior of rotating or reciprocating machinery for 
which the rotational speed can change over time. Unlike the power spectrum and 
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other frequency-domain analysis functions where the independent variable is 
frequency, Order Tracking functions present the data against multiples (Orders) of 
the variable shaft running speed.  

The most useful measurements are Order Spectra and Order Tracks. An Order 
Spectrum displays the amplitude of the signal as a function of harmonic orders of 
the reference shaft‘s rotation frequency. This means that a harmonic or sub-
harmonic order component remains in the same analysis line (at the same 
horizontal position) regardless of the speed of the machine.  

The technique that observes the changes of a measured quantity at a given order vs. 
RPM is called tracking, as the rotation frequency is being tracked and used for 
analysis. Most of the dynamic forces exciting a machine occur at multiples of the 
rotation frequency, so interpretation and diagnosis is greatly simplified by use of 
order analysis. 

An Order Track is simply the history of measured amplitude at a single order versus 
the machine shaft speed (in RPM). There are other types of tracking functions. For 
example, you can track the FFT-based PSD spectra, a fixed band or an octave band 
versus RPM; all of these are tracking functions.  

Capabilities of the Spider 

The processing repertoire of Crystal Instruments‘ Spider includes performing Order 
Tracking functions. With the CI Order Tracking package, the Spider can: 

 Measure and optionally record up to two (analog or digital) 
tachometer pulse signals simultaneously.  

 Measure and optionally record 1 to 8 analog dynamic response signals 
simultaneously. 

 Process both tachometer signals to yield high fidelity RPM versus time 
speed signals (Tach Ch1 and Tach Ch 2) which can in turn be recorded. 

 Measure the constant frequency spectrum, also called as the FFT 
spectrum for up to 128 channels (requires multiple Spider modules). 

 Measure the Order Spectra for up to 128 channels 
 Measure the Order Tracks with phase for up to 128 channels (Can 

include multiple orders, including fractional orders for each channel). 
Measure the energy in fixed frequency bands vs. RPM for up to 128 
channels 

Applications 

There are several different applications for order tracking.  A discussion of some is 
given below. 

The first application, often referred to as Run Up/Run Down, is used to survey a 
machine‘s dynamic response when the operating RPM is varied across the entire 
operating span. In this case, the RPM range can be very large, from a few RPM to 
10,000 RPM. Such tests are run on automotive or aircraft engines and when 
commissioning new or refurbished stationary processing equipment. The 
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measurements can be any physical quantities such as sound, displacement, velocity, 
acceleration, torque, etc. The analysis measure can be the amplitude or the power of 
an order, the energy over a fixed frequency band, a bin of octave filter, etc.  The 
most important result for this type of measurement is the magnitude of the 
response versus RPM.   

The second application is monitoring measured machine displacement, velocity, 
acceleration, pressure, current or sound while the machine is performing its normal 
duty. The instrument measures the amplitudes of specific orders and their phase 
relative to a reference tachometer input signal. The phase is calculated relative to 
the tachometer input or a separate reference input. This application is common for 
machine diagnosis and balancing. In this case, the operating RPM is relatively 
stable. Order tracking technology is useful to increase the accuracy of the estimation 
of orders.  

Order Track signals with phase are useful in the study of rotating machine during 
Run Up/Run Down. This is often presented as a ―Bode Plot‖, useful in 
characterizing resonance/excitation intersections. The Bode Plot is a concept 
borrowed from control theory; it provides simultaneous Amplitude and Phase data 
over a changing speed range (i.e. Run Up or Coast Down). Some of the setup 
information depends on the rate of change of the RPM.  The Run Up or Coast Down 
could take anywhere from a few minutes to a few hours (such as for a cold startup 
on a turbine).  

Understanding Order Tracking 

Resolution and Span 

In fixed-bandwidth operation, an analyzer collects N successive samples from an 
analog time-history at a sample rate, fs. The analog signal is pre-filtered by a low-
pass anti-aliasing filter set to the desired analysis frequency range, Fspan and the 
sample rate is set to k Fspan, where k is a constant specific to the analyzer. Each 
captured time-history is transformed to yield a spectrum. The following spans and 
resolutions result: 

 
 
 
 

 t = 1/fs= 1 / k Fspan time between adjacent time points (S) 
 

 Tspan = Nt  duration of each time capture or memory load period (S) 

   

 F = 1/Tspan  difference between adjacent frequency points (Hz) 
 

 Fspan= NF / k  frequency range presented (Hz) 

 
In order-normalized (order-tracked) analysis, both the frequency range and sample 
rate must vary in proportion to the machine speed. This is accomplished by 
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measuring the shaft speed with a tachometer and deriving a sample rate equal to k 
Ospan times the instantaneous shaft speed. Ospan is the maximum number of shaft-
speed orders (multiples) to be measured in a spectrum. The effective anti-aliasing 
filter must constantly adjust to limit the incoming signal bandwidth to Ospan times 
the shaft-turning frequency. This results in the following spans and resolutions: 

 R = 1/fs= 1 / k Ospan shaft-angle between adjacent signal samples (Revolution) 
 

 Rspan = NR  number of turns in each memory capture (Revolution) 

   

 O = 1/Rspan  difference between adjacent order points (Order) 
 

 Ospan= NO / k  order span presented (Order) 

 
Typical analyzers require between 2.56 and 4 samples per maximum order 
spanned. This is the same k multiple relating the analyzer‘s sample-rate to the 
frequency band studied in normal fixed-bandwidth analysis. The exact numeric 
value is determined by the analyzer‘s design specifics. 

Processing Concept 

 

The vibration signal is sampled by an ADC that runs at a constant 102.4 kHz 
sample rate and is protected by a fixed-frequency anti-aliasing filter. The 
bandwidth of this filter, Fspan, is selected such that … 

 Fspan>RPMmax x Ospan/ 60 

… whereRPMmax is the maximum machine shaft speed to be analyzed and Ospan is 
the maximum order of shaft rotation to be analyzed. The sample-rate, fs, is set to a 
deliberately high value with regard to the input filter. 

The resulting highly over-sampled digital time history is passed to the input 
memory of a digital reconstruction (amplitude-interpolation) filter. While this filter 
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updates at the input sample rate, the output of this low-pass filter is sampled at a 
fixed number of times per shaft revolution. These sample times are not uniformly 
spaced in time. Rather, each sample is taken at a time corresponding to a shaft 

rotation of R from its predecessor. These fixed-angle sample times are computed 
from the successive periods of the tachometer signal.     

The tachometer pulse train is applied to a precise timing circuit which measures the 
period between adjacent pulses. The two most recent periods are sent to curve-
fitting and interpolation modules which compute the appropriate times at which to 
sample the interpolation filter‘s output. The sample times are computed based 
upon the assumption that the shaft experiences a constant angular acceleration 
between adjacent tachometer pulses. This real-time process accepts input (n) and 
output (N) pulse-per-revolution sampling constants, allowing the use of one or 
more equally spaced tachometer pulses per shaft rotation. 

The resulting digital angle-history is presented for subsequent FFT and average 
processing. The interpolation filter introduces a processing delay between ADC 
input and the presentation of the angle-history. However, this delay affects all 
channels identically and the process proceeds in real-time without compromise.  

After data re-sampling, a discrete Fourier transform (DFT) algorithm can convert 
the angle-history into the order domain. While many competitive systems employ 
―power-of-two‖ FFTs that restrict block size to be a binary number, Crystal 
Instruments utilizes a more flexible algorithm that allows this dimension to be a 
product of prime numbers (i.e. 1, 2, 5). This allows selecting ―nice numbers‖ for 
resolution and span in all domains. 

Tachometer Processing and RPM Measurement 

A tachometerconverts the angular velocity of a rotating shaft into an electrical 
signal, typically a voltage. Tachometers with a DC proportional to speed output are 
totally unsuitable for order analysis. A far more precise device generating pulses on 
an equal-angle spacing is required. While it is possible (subject to restrictions) to 
analyze the orders of a rotating shaft based upon a once-per-turn tachometer pulse 
such as that generated by a keyway-viewing proximeter (a key-phasor probe), a 
stable multiple pulse-per-revolution signal provides far better angular resolution. 
This is the domain of the shaft encoder, an electro-optical device that produces a 
train of n logic-level pulses per shaft revolution. (Be very wary of ―homemade‖ 
multi-pulse tachometers; uneven target spacing can generate the false impression 
that the shaft speed is modulated.) While less facilitating, a once-per-turn pulse 
signal can be used to synchronize an order analysis. An example of a once-per-turn 
optical tachometer is shown in the figure below. 
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Figure 169. Optical tachometer setup. 

This 1/turn pulse must be used to facilitate N/turn sampling of a machine‘s 
dynamic signals.  In the ancient days of yore, a complex accessory box called a 
tracking adaptor was used to provide this sample-rate multiplication. The tracking 
adaptor (tracking ratio tuner) was comprised of two components, a phase-locked 
loop (PLL) and a voltage-tuned filter. The PLL accepted a variable frequency input 
pulse train (i.e. 1/rev) and provided an output pulse train at a higher frequency of 
exactly M/D (M and D being available integer settings) times the input rate; this 
pulse train became the order-normalizing sample rate. The second component was 
a voltage-tuned low-pass filter driven by the PLL phase error (an analog voltage) 
that tracked the sample rate and was thus a tracking anti-aliasing filter, expanding 
and contracting its passband in tune with machine speed.  

Today‘s digital re-sampling algorithm does away with the need for an external 
tracking adaptor. It provides better tracking because of its fundamental assumption 
that the shaft changes speed with constant angular acceleration between pulses. 
The phase-locked loop circuit implied a tacit assumption of constant angular 
velocity between tachometer pulses.   

The Spider-80x modules provides for high-fidelity sampling of the tachometer 
signal to preserve the details of its waveform. Regardless of the sample rate applied 
to the input channels, the tachometer is recorded as a time-stream at the 
instrument‘s maximum sample rate of 102.4 kHz. A dedicated high-speed counter 
precisely measures the period between adjacent tachometer input pulses.  

 

This special hardware circuitry allows the dedicated tachometer channel to sample 
at the highest possible sampling rate. This technique has several obvious 
advantages: 

 The time domain signal of the tachometer input is transformed by 
A/D converter into a digital signal. The user can observe the pulse 
trains of the tachometer signal and set threshold arbitrarily. 
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 Accurate phase information can be obtained relative to each data 
channel because the tachometer channel, which is fed by high 
frequency sampling oscillator, is synchronized with data channels. 

 The RPM estimation is not influenced by the current data sampling 
rate.  

 Two independent tachometer input channels provide independent 
RPM signals simultaneously.  

 A reconstructed series of pulses at instants when the tachometer 
generated a pulse is created and can be used for analysis. 

 

Pulse per Rev is defined as the number of tachometer input pulses per shaft 
revolution. Pulse per Rev must be defined by the user so that the instrument can 
calculate the shaft frequency from the tachometer frequency. The relationship is: 

Tachometer Reference freq = Tachometer freq / Pulses per Rev 

Revolution Period = 1/(Tacho Ref Freq)
Pulse Period = 1/(Tacho Frequency)

 

In most tests, the Pulses per Rev will be 1. (Sensing a keyway or other once/turn 
target is relatively simple.) However, in other situations, such as viewing a toothed 
flywheel or reference gear, the Pulses per Rev can be as high as hundreds. In 
general, the higher the Pulse per Rev, the more resolute an order analysis becomes. 

Pulse Detection 

A good tachometer processing instrument allows the user to see the tachometer 
signal in its original time waveform. This aids setting the threshold of pulse 
detection, simplifying tachometer setup. 

Order Tracks and Order Spectrum 

Synchronizing the sampling to the rotating speed allows presentation of 
measurement results in the angle and order domains in lieu of the time and 
frequency domains. An order is simply a frequency divided by a reference frequency, 
normally a machine‘s shaft-turning frequency. This means that the order location in 
an order-normalized spectrum indicates the number of vibration cycles per shaft 
revolution. The tracked magnitude (which can be measured using EUpk, EUrms, or 
EUrms

2) of an order is the measurement extracted through a tracking filter with its 
center frequency located at this order.An Order Power Spectrum measurement 
gives a quantitative description of the amplitude, or power, of the orders in a signal. 
It provides a good view of all order components of a signal. This can help you 
rapidly identify significant forcing mechanisms.  

The following figure shows conceptually how angle re-sampling can be used to 
analyze vibrations from an engine during start up. Once the signal has been 
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transformed into its angle domain, the FFT can be applied to analyze the order 
spectrum of the vibrations.  

Engine Speed in 
RPM

Uniformed Sampled Data

Uniformed Sample Rate

Order Spectrum

Synchronously Sampled Data (sampling rate is 
determined by both instantaneous tacho speed 

and required analysis frequency range)

Frequency Spectrum

Analog signal overplot with 
4X per revolution 
tachometer signal

 

Figure 177:  Angular data resampling of a chirp signal 

An important concept that must be introduced now is called ΔOrder (delta order). 
In the FFT based frequency spectrum analysis, the frequency span and frequency 
resolution are fixed. The capability of discriminating frequency components is 
equal in both low and high frequency. In rotating machine analysis, we need to have 
better analysis resolution in the low frequency than that in high frequency. For 
example, if the rotating speed is at 60 RPM, we definitely care if the instrument can 
tell the difference between 1Hz (order 1) and 2Hz (order 2); in contrast, if the 
rotating speed is at 6000 RPM, the user probably won‘t care if the instrument can 
discriminate the measurement between 100Hz (order 1) and 101Hz.  

With the digital resampling technique, the order tracks and order spectrum are 
extracted based on a filter with equal ΔOrder instead of equal ΔFrequency. The 
concept is illustrated in the following figure: 
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Figure 178: Comparison of constant band tracking and digital re-sampling 
method. 

The left figure shows when the order tracks are extracted using conventional FFT 
method with fixed resolution, the ΔFrequency of the tracking filter will be fixed; the 
right figure illustrates that if the order tracks are extracted using digital resampling, 
the ΔFrequency tracking filter will be increased proportionally with the RPM. 
Obviously, the method of digital resampling is more desirable in extracting the 
measurement of orders. 

FFT Spectrum or Constant Bandwidth Spectrum 

Constant bandwidth spectra (FFT Spectra) remain an important tool for the 
diagnosis of mechanical problems. While an order spectrum is ideal to track the 
behavior of a machine‘s forcing functions, and FFT is ideal for tracking its 
resonances. Further, various 3-D visualization tools make it easier to understand 
the interplay of these two machine characteristic. For example, a series of FFT 
Spectra can be cascaded (by time or by RPM) in a 3D waterfall as shown below: 
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Figure 179:3D FFT spectrum 

The above FFT waterfall presents a sequence of Amplitude-versus-Frequency traces, 
each measured at a different operating RPM.  The horizontal axis of the 3D RPM 
Spectrum is frequency. The vertical trace amplitude is in G‘s (or some other 
vibration transducer‘s units). The inclined z-axis is represents RPM, with constant 
ΔRPM spacing between the traces. A color map can also be used to describe the 
magnitude of the whole range as shown below. 

 




